Contents

Chapter 1 Introduction ................................................. 1
  1.1 What is ICON-NMR? ............................................. 1
  1.2 What’s new in ICON-NMR .................................... 2
  1.3 Hardware/software requirements ......................... 11
  1.4 Support ...................................................... 12
  1.5 Installation of ICON-NMR ................................. 12
  1.6 Starting up ICON-NMR ...................................... 12
  1.7 Configuration Options .................................... 13
  1.8 Using the mouse or the keyboard ....................... 14
  1.9 Troubleshooting ............................................ 15

Chapter 2 The Main Desktop ................................. 19
  2.1 Overview .................................................. 19

Chapter 3 Automation ............................................ 23
  3.1 Entering Automation mode ............................... 23
  3.2 The Automation Setup Window layout ................. 23
  3.3 Automation Quick Start Guide ......................... 26
  3.4 Component Descriptions ................................ 28
  3.5 Menu Bar commands ..................................... 37
  3.6 Automation Window Tips ................................ 40
  3.7 External Setup ........................................... 41
  3.8 WEB Interface ............................................ 49
  3.9 Selective Experiments inside ICON-NMR Automation 54

Chapter 4 Toolbox Automation Extension .................. 57
  4.1 What is the ICON-NMR Toolbox? ....................... 57
  4.2 When should I use the Toolbox? ....................... 59
  4.3 Entering Toolbox Mode .................................. 59
  4.4 The Toolbox Window layout walk-through .............. 60
  4.5 Menu Bar commands ..................................... 69
  4.6 ToolBox Usage/Adaptation ............................. 72
  4.7 NMR Biotools ............................................. 75

Chapter 5 Configuration Suite ............................. 79
  5.1 Overview ................................................. 79
  5.2 User Settings ............................................ 81
  5.3 Composite Experiments ................................. 97
  5.4 Automation Window ................................... 100
  5.5 Automation Driver Engine ................................ 102
  5.6 Automatic Tuning/Matching ........................... 112
  5.7 Priority Options ......................................... 113
  5.8 LC-NMR Options / Sample Track Options .............. 114
Chapter 6  **Routine Spectroscopy**  121

6.1 Entering Routine Spectroscopy mode  121
6.2 User identification  121
6.3 The Routine Spectroscopy desktop  123
6.4 The Inject/Eject icon  125
6.5 The Filename icon  126
6.6 The Solvent icon  128
6.7 The Experiment icon  129
6.8 The Start icon  131

Chapter 7  **The Accounting Manager**  135

7.1 Introduction  135
7.2 The File menu  137
7.3 The Report menu  137
7.4 The Accounting for box  137
7.5 The Accounting Period and Unit Prices  139
7.6 The Start button  140

5.9 Temperature Handling  115
5.10 Fail Safe / Error Handling  115
5.11 General Options  116
5.12 File Menu Functions  119
Chapter 1

Introduction

1.1 What is ICON-NMR?

Welcome to ICON-NMR, a comprehensive user interface, tailor made for all your NMR laboratory management and control needs. ICON-NMR was designed to make the execution of routine NMR experiments easy and straightforward by providing a state of the art icon based user interface. The steps necessary to acquire, process, and plot a spectrum are reduced to inserting a new sample, defining the data file name, the solvent, and the experiment. No other knowledge about the instrument, the parameters, or the software is necessary. Although running on top and under the control of the computer’s Linux/Windows operating system and Bruker’s TOPSPIN program, providing the acquisition and processing functions, ICON-NMR shields the user entirely from both. Accessing TOPSPIN commands is only possible if permission has been granted by the laboratory manager. As such, ICON-NMR is particularly suited for open access spectrometers with a large number of users.
1.2 What’s new in ICON-NMR 4.2

1.2.1 Automation

- **SampleJet support**
  Icon 4.2 includes support for the new Bruker SampleJet Sample Changer. A dedicated Sample Holder overview window along with a configuration option to control the measurement sequence order of experiments is provided. The Automation driver routines have also been optimized to take full advantage of the hardware performance. Icon also fully supports the interfacing of this new unit to Bruker’s SampleTrack Laboratory Management software.

- **Search history files**
  A convenient search tool has been added to search all entries from preceding experiments performed within all Icon-Nmr Automation runs. Search for multiple items in an experiment's title text, dataset name or a particular remarks message. A list of data sets is generated in the same manner as the Preceding Experiments (history) list which may be then used to navigate easily to the respective data set.

- **Web-Icon Improvements**
  Experiments may now be remotely edited via the Web interface. A time-out feature has also been added to logout idle web users, improving security and throughput. Parameter modifications may also be made to component experiments belonging to Composites.

- **Remarks field now shows process messages**
  Should any procedure generate an error, info or warning text during sample measurement, a copy of the text can appear in the “Remarks” column of the Preceding Experiments (History) list.

- **Import an Experiment/Data Set from TopSpin (S)end (T)o (I)con**
  Use the new command “sti” (Send to Icon) in TopSpin to grab a copy of the current data set and enter it into any position in the Automation window for measurement. All Automation features are now available for the measuring the data set in its current state as if it had been created by Icon. This command is also available inside the Automation window via the new “Tools” Menu.

- **Run an experiment Periodically**
  Use this new feature via the new “Tools” menu to queue any experiment to be
submitted automatically at regular intervals, any number of times. Experiments are submitted with the priority flag set.

- **Failsafe watchdog timer**
  If any phase of the measurement takes longer than expected, the run will be restarted, and the action which failed to complete also restarted. The Automation run will no longer be blocked by any processes which fail to respond. The time allotted for waiting may be configured and where necessary this system may be circumvented.

- **Zip copy, Zip data mail (User Manager) permission**
  Icon can now generate Zip files of the generated data sets as part of the run. These can be emailed in the same manner as JDX files have been up to now. Zip Files may also be copied to a particular directory if required, in the same manner as the JDX-Copy mode.

- **Originator Regular expression check**
  Originator item information may be screened according to syntax rules. This will further reduce the likelihood of incorrect sample information being entered when samples are being submitted. Search the web for more information on how to use/set up a regular expression.

- **Preliminary Form Style entry mode**
  This method of submission may be useful when the instrument is working in environments where access to the instrument needs to be streamlined. Here the sample position, data set name and experiment number is managed automatically (using either the Spectrum Number Filename or User Manager Data Set Name entry). All that remains is for the user to set Solvent and Experiment and Title/Originator Info.
  Comments on this new system please to nmr-software-support@bruker.de.

- **Structure consistency check**
  An additional entry field may optionally be added to the Automation window where a Mol/SD file may be set which will be used on HSQC experiments to perform an automated structure consistency check. This feature requires the Perch Software Tools.

- **Color/Theme support under Linux**
  Change the colors used and look and feel of Icon-Nmr directly from the Linux Desktop Control Panel. Icon will adopt the standard look and feel of other programs running under Linux. Windows Users will also notice more conformity with the desktop settings.
• **Additional Automation Configuration Settings**
  Night time experiments may now be treated as single entities when determining whether they should be run in idle instrument time. See the “Determine idle case based on total submitted experiment time per sample” check button.

  Optionally Hide or Disable the Disk column.

  For SampleTrack operation, set the number of digits which a BACS bar code reader will expect to read.

**Miscellaneous Improvements**
Toolbox/BioTools contains new updated Experiment Definition files, with even more experiments.

In the Spreadsheet Import dialog, it is now possible to specify that the sample position be taken from a particular column of the sheet. Multiple experiments for a single sample no longer need to be defined as composites.

External Setup Files may contain new keywords NIGHT for night experiments and MOLFILE to perform the Structure Consistency Check with a particular Molfile.

New previous experiments (history) “Load” column, depicts whether a sample was inserted into the magnet correctly.

Questions issuing from TopSpin may be automatically answered with an automatically generated “Cancel” click, thus preventing any Automation Lockup when no operator is present.

**1.2.2 Look back: New in ICON-NMR 4.0**

• **New Fully sortable and adjustable history table**
  In Automation mode clicking on the header column of the performed experiments table causes the table to be sorted based on the contents of that column. Individual columns may be moved to other locations providing for improved readability.

• **Automatic Shimming Routine variable based on Probe/Solvent Setting**
  A solvent/probe dependent shim routine may be defined on the configuration solvent/probe dependencies page. This will then override the default shim routine when the solvent/probe combination is being used.
1.2 What’s new in ICON-NMR 4.2

- **Temperature Handling on a per experiment basis instead of per sample**
  Use of the au program au_zgte is no longer necessary. Parameter set temperatures are checked on each individual experiment and the temperature equilibrium routine is called intelligently (only when necessary).

- **Standard Originator Values available in the Automation window**
  All originator items have a pull-down window containing values which may be defined by the System Administrator. The list may be read-only editable and may automatically save new values where required.

**Icon-Web Improvements**

- **Samples on-edit are monitored**
  If a user is already adding samples via the web interface, a second user will not be permitted to add experiments for the given sample position.

- **Arbitrary data set names accepted**
  Names which were not already in use on a holder or which were not entered in the User Manager are now permissible in the Icon-Web Create Experiment Window.

- **New “Queue Interaction” permission**
  This option may be used to prevent display of Submit, Cancel, Add and Delete buttons in the web browser, providing a ‘View Only’ mode.

- **Simplified LCNMR Driver Interface**
  Many of the features which were already provided for in other Configuration windows have had their duplicates removed from the LCNMR page.

- **Holder Display now supports LCNMR/SPE mode**
  2 96'er well plates are now displayed in the Sample Holder Overview window and may be used to quickly select the correct LCNMR sample.

- **Easily setup multiple groups of experiments on a single sample**
  Right click on any sample/experiment and click on the Iterate button to make duplicates of the experiments already present on that holder. The number of duplicates to make is determined by the Copy count setting.

1.2.2.1 Toolbox/Nmr Biotools New Features

- **Support for easy duplication of complex experiments.**
  The experiment tree in the toolbox widget normally contains one instance of each type of experiment according to its experiment definition file. This experiment may now be duplicated simply by clicking on the experiment's entry in
the tree after it has already been submitted. An additional entry for the same experiment is added to the automation queue and may be modified inside the toolbox before subsequent submission.

- **Standard Title Information may now be embedded as integral part of an experiment definition file.**
  When an experiment title text is always to appear in toolbox experiments, enter the title before saving an experiment definition file. Every future instance of the experiment will have the title set per default and may be edited in the normal fashion before submission.

- **Parameter Arithmetic may be included in the experiment definition.**
  Parameters may be automatically set to values which may be the result of parameter arithmetic run either when the experiment is instantiated or at experiment run time. This is achieved by means of the syntax `CMD {setpar "parameter name" "parameter value"}` syntax. Parameter value may be a mathematical TCL expression which works with experiment definition variables e.g. `[expr {$SWN($HOLDER) / 2}]` within the default parameter values commands window. Here as a trivial example:
  `CMD {setpar d1 [expr {100 * $D1($HOLDER)}]}`
  Here the value of d1 would be automatically set to 100 times the value of the variable D1(HOLDER) before acquisition and on experiment instantiation.

1.2.2.2 General

- **Updated User Interface, now even friendlier, more streamlined operation**

- **In Accounting, Originator Items may now be searched using wildcards**
  For any Originator based search the text to be found may contain an asterisk (*) to match multiple characters or a question mark (?) to match any single character. For example, when searching for an experiment which was run by the Originator Laboratory "Lab1", L*1 would find both originator items "Laboratory1" and "Lab1".

- **Facility to remove old entries from Accounting Files**
  Entries may be removed prior to a particular date from both Inmracct.brief and Inmracct.full files. This feature is accessible from the Configuration->Accounting window.

- **German language version included**
  On the Configuration->General Options page use the Display->Language setting to alternate between languages.
1.2 What’s new in ICON-NMR 4.2

• **Weekend Specification possible**
  Previously Saturday and Sunday were always treated as being ‘night time’ by the software. This may now be altered via the Configuration->Priority window.

• **New ‘Manual’ entry on running selective experiments inside ICON-NMR.**
  See “Selective Experiments inside ICON-NMR Automation” on page 54.

1.2.3 Notes:

• **Feature Change in the Web Icon Interface Configuration page.**
  When individual users were granted access to the Web Interface, a field “Enable” governed whether the user could use the Web Interface or not. This field is now called “Queue Interaction” and determines whether the user has access to the Submit, Add, Cancel and Delete buttons and as such as to whether a user can remotely control samples on the queue or just simply monitor its progress. Should the old handling be required simply remove the users entry from the table and access for that user will be denied.

• **Support has been discontinued for the Routine Spectroscopy interface.**
  Functionality improvements will no longer be applied to this product. Users are encouraged to use the Automation interface for your individual automation requirements.

1.2.4 Look back: New in ICON-NMR 4.0

1.2.4.1 Automation

• **ICON-NMR now available online**

  ICON-NMR is now web-enabled. The standard Bruker Automation Software now provides a built in web-site which can be activated to allow remote access to ICON-NMR from any web browser. The browser only requires access to the spectrometer workstation via an intranet or internet connection. Experiments may be cancelled/submitted, the run may be paused or halted and spectra in PDF format are available from the browser window. No added software apart from ICON-NMR is required and configuration is via the standard ICON-NMR Configuration window. For security a SSL/HTTPS connection is supported. Pocket PC Internet Explorer is also supported for full spectrometer control via Windows Mobile 2003 (TM) or equivalent. PDF files of spectra may also be viewed on this platform making the mobile pocket spectrometer a reality.
Configuration Option to allow for termination of the NMR Measurement if the automatic shim routine fails

Automatic Tuning and Matching (ATM) may be set to run in a faster "Coarse" mode. See the Configuration->Automatic Tuning Matching page

Temperature Handling Post Insertion Set/Check available for Six Pack/NMR Case Automation systems

Use the right mouse button in the Automation Window to Submit/Cancel/Add experiments.

Configuration Option to prevent NMR Data being overwritten. Note As all previous versions of ICON-NMR did not have such a check, the default setting is disabled. The archive data option generates a backup copy of the data which is never overwritten, regardless of this setting.

1.2.5 Notes:

- Change in accounting program

The accounting algorithm has been modified to treat experiments measured at the weekend as night experiment time. Up to now experiments measured during the weekend were treated in exactly the same way as non-weekend experiments.

- Notification/Data Mail/PDF/Error E-mails from ICON-NMR

ICON 4.0 includes software to deal directly with SMTP Mail Servers. This means that use of the "mutt" mail program under Linux and the default Windows® MAPI Mail program is no longer required.

The SMTP Mail Server is set in the Configuration->General Options window. If no entry is made ICON tries to use the old mailing method.

Contact your IT department for the correct SMTP server name.

- Supervisor Mode on Linux Systems:

This functionality has been adapted to work correctly with the KDE and
1.2 What’s new in ICON-NMR 4.2

GNOME window managers. Users will however in such cases still have access to the desktop. If access to the desktop is to be denied the Motif Window Manager (mwm) should be used. This may be started by selecting the “Failsafe” Session setting before login. Then start the mwm window manager by typing `mwm&` After this step start an additional terminal window with `xterm&` and start TopSPIN from this new window.

If mwm is not available on your system you may install it from the openmotif rpm file found on the TopSPIN DVD in the linux/rpm directory. Usually this is done with the rpm -i filename command.

Other window managers may also work correctly.

- **Notice of multiple .set/.hist files hoarding disk space**
  When leaving the Automation interface the software checks the disk to see how many directories are present in the TOPSPINHOME/prog/curdir/changer directory where ICON stores its files. Move/Delete these old files to save space and avoid the warning message!

- **ATM supported in Routine Spectroscopy mode**

1.2.6 Look back: New in Icon-NMR 3.7 (since ICON-NMR 3.5)

1.2.6.1 “NMR Biotools”

The NMR Biotools program is a new front-end to the 3D Toolbox utility familiar from previous releases. This new package unlocks the power of multi-dimensional NMR for casual and first time ‘Bio’ users. Automatic Calibration, Customized experiments based on protein size, molecular weight/labeled nuclei etc. along with the inherent flexibility via its ‘Expert Mode’ to fine tune the system to suit any lab are just part of its features. Access the program via the Topspin Spectrometer menu or the biotools command.

“NMR Biotools” is available by typing the command `biotools` in TopSPIN. The interface decides which group of experiments will be employed, depending on targeted user input accumulated when the program is launched. No previous experience of the Toolbox software is required. All essential input required for experiment execution is gleaned from the user automatically.
1.2.6.2 Automaton (General)

- Priority includes a new Randomize feature which uses a random number generator to arbitrarily jump from one submitted sample to any other without any systematic governing the order. This can be useful for statistical methods.

- Priority Night Experiment Duration for Idle limit
  Night experiments could always be run in Idle day time, but now you can specify just how long a night experiment can be and still be measured in Idle day time. This prevents any long “night-time” experiments creeping into idle day time and blocking other critical experiments.

- Display/Document only Configuration Items defined for the user
  Up to ICON-NMR 4.2, any defined originator Items were always shown in the title window for a given user. Now when this configuration flag is activated, only those ones defined for the user (in the User Manager window) will appear.

- Units for User Specific Parameters are shown (where applicable)

- New ‘Remarks’ field added to history window showing details of any errors or anomalies which may have occurred

- Mail addresses used inside the ‘Title’ window are saved and may be accessed via a pull-down window.

- The contents of the setup window may be saved as an external setup (extset) file.

- The program now includes an “Express Setup” window which appears the very first time the program is started on a new system.

- Clicking on Change User is now sufficient to Lock the Automation window.

- Used entries now appear light green in the “Sample Holder Overview” window.
1.3 Hardware/software requirements

Computer and Operating System:

*Linux Red Hat:* See the TOPSPIN 2.1 release letter.

*Microsoft:* Operating System *Windows 2000 or Windows XP*  

*Spectrometer:* See the TOPSPIN 2.1 release letter

Software:

TOPSPIN 2.1 must have been installed prior to ICON-NMR 4.2

Release Media:

ICON-NMR 4.2 is available on the TOPSPIN 2.1 DVD.

This manual applies to ICON-NMR version 4.1. ICON-NMR contains this manual as on-line documentation accessible from the *Help* menu.

ICON-NMR 4.2 provides the *Routine Spectroscopy Desktop* for experiments *without* a sample changer, the *Automation Desktop* for multiple experiment execution with or without a sample changer and the *ToolBox* interface for performing complicated experiments efficiently. The *ToolBox* has a simplified *NMR Biotools* interface for even easier access to the 3D capabilities of your Spectrometer. This interface is available via the TOPSPIN *biotools* command.

**BEST-NMR:**

BEST-NMR users should note that there are considerable changes to both the software and more importantly the hardware required to run BEST-NMR in ICON-NMR 4.1 when upgrading from a previous 3.0 or earlier ICON-NMR release.

Users who are currently using BEST-NMR with a ICON-NMR 3.0 or earlier version are advised to defer upgrading their TOPSPIN/ICON-NMR software until they have all the necessary components. Methods will also need to be converted before they may be used in BEST-NMR/ICON-NMR 4.1. A conversion routine is provided from within the bestadm->methods user interface.

Contact your local Bruker Supplier for an upgrade kit.
1.4 Support

Software support is available from your local Bruker office or via e-mail from the following address:

nmr-software-support@bruker.de

The Bruker www servers www.bruker.de and www.bruker.com provide additional information such as downloadable upgrades for your ICON-NMR installation.

1.5 Installation of ICON-NMR

Please proceed as described in the TopSpin 2.1 Installation Guide. ICON-NMR can be separately selected as an installation item from the TopSpin installation dialog window.

1.6 Starting up ICON-NMR

1.6.1 TopSpin configuration

Before you can start ICON-NMR and begin your work, the laboratory manager must have installed TopSpin 2.1 and ICON-NMR from the release media. In addition, the cf TopSpin Spectrometer configuration command (see the TopSpin manual) must have been executed successfully.

Notes on TOPSPINHOME:

When you install TopSpin from the distribution DVD on Linux systems, you may either choose Standard Installation or User-Defined Installation. The standard directory is /opt (Linux) or “C:\Bruker\TOPSPIN” (Windows 2000/XP), the user-defined installation allows you to specify any directory. In this manual the actual installation directory of TopSpin is ‘TOPSPINHOME’. All program modules of TopSpin as well as some utility programs such as the Service Tools are located in TOPSPINHOME/prog and its subdirectories. All parameter sets, pulse programs, AU programs, etc. are located in TOPSPINHOME/exp and its subdirectories. The
spectrometer configuration files are located in \texttt{TOPSPINHOME/conf} and its subdirectories. The plotter and printer configuration files are located in \texttt{TOPSPINHOME/plot} and \texttt{TOPSPINHOME/print/} and their subdirectories, respectively.

Select one of the following methods to start ICON-NMR.

- **Starting ICON-NMR from TOPSPIN level**
  If \texttt{TOPSPIN} is active, enter the command \texttt{iconnmr} in its command line, or call it from the Acquisition menu inside Topspin.

- **(Autostart) Have Topspin start ICON-NMR Automatically**
  Use the \texttt{autostart} feature in TopSpin to start ICON-NMR automatically. The autostart.prop file may be configured to contain a command which will start iconnmr as soon as TopSpin has started. Open the TopSpin User’s Guide and do a search for autostart for more details. Possible commands include:
  - \texttt{iconnmr} or \texttt{icon-} starts the main ICON-NMR window
  - \texttt{icona} - starts Automation
  - \texttt{iconc} - starts configuration
  - \texttt{iconr} - starts Routine Spectroscopy
  toolbox and biotools are also available.

### 1.7 Configuration Options

The first time any user uses ICON-NMR a default user file will automatically be created allowing full access to the program. It is required, however, that the Laboratory Manager create userfiles for those who will be using the program. All aspects of the software may be configured via the \textit{Configuration} button of the ICON-NMR main window and is described in detail in that chapter of this manual.

System and user management comprises the following items:

- Defining the legal spectrometer users
- Defining the experiments a particular user may execute
- Defining a number of permissions for a user, e.g.
  - whether he is allowed to change the parameters of an experiment
  - whether he may exit from \textit{Routine Spectroscopy/Automation} mode to \texttt{TOPSPIN}
  - whether he is allowed to lock and shim a sample manually
  - file name restrictions
Defining user specific information, such as e-mail address or a costing group (via User Specific Originator Info in the User Manager)

- Defining the disk directories in which to store the acquired data
- Defining new composite experiments, i.e. several experiments combined under one name
- Configuring ICON-NMR’s Automation module and Default Shim file loader
- and much more...

1.8 Using the mouse or the keyboard

**Special keys active in Automation mode:**

- In *Automation* mode scrolling up and down in the experiment display area may be done with the `Alt + z` and `Alt + x` key combinations respectively.
- Use `Alt + Tab` in the Title window in *Automation* mode to select the next button/entry. (`Tab` on its own is taken as being a normal `Tab` indent function)
- The `Esc` key may be used to break out of any recursive action, e.g. a copy or multiple experiment parameter edit.
- On Originator Item entries in automation where standard values are available, typing the first letter of the required value will open the combo box at the alphabetically sorted index closest to that character. When the entry is editable, use the ‘Down’ arrow to open the combo box.

**Using Function Keys:**

- For ICON is to recognize Function Key input, create a resource file called `_iconnmrrc` in the home directory of the user who normally starts TopSpin for ICON-NMR use. If you’re not sure what you’re home directory is, close ICON-NMR and restart it with the command ‘icon info’ in TopSpin. Your home directory will be displayed in an additional window.

Here is an example of one such resource file which defines F1 for ICON-NMR use. Put both of the following lines in your `_iconnmrrc` file to be able to use the F1 key in your Title and Originator entries:

```plaintext
bind Entry <F1> { %W insert insert “This is F1” }
bind Text <F1> { %W insert insert “This is F1” }
```
1.9 Troubleshooting

What to do if ICON-NMR doesn’t start:

1.9.1 Recreate the Configuration Files:

ICON-NMR uses regular Ascii files to store configuration information from session to session. Should these files become corrupted the program may not be able to start correctly. Try renaming the following directories/files so that ICON-NMR has to create them again.

TOPSPINHOME/conf/instr/<Instrument Name>/inmrusers/
and

TOPSPINHOME/prog/curdir/<User Name>/.inmrcconfig

1.9.2 De-activate Windows Domain Accounts

If your Workstation is part of a large Windows Domain, it may take ICON-NMR quite some time to get the user information from the domain controller. Some domain controllers handle thousands of users and waiting for an answer may take several minutes. Icon uses this information to provide an up to date list of available users in the user manager. If the domain controller is experiencing problems or your network connection to the domain controller is impaired, this information may never become available.

You may circumvent this check by adding the following line in the _iconnmrrc file in the home directory of the user who starts ICON-NMR:

set DOMAIN_USERS off

If you’re not sure what you’re home directory is, close ICON-NMR and restart it with the command ‘icon info’ in TopSpin. Your home directory will be displayed in an additional window.

If the file does not exist, create it. This file will then override the internal setting in ICON-NMR and will be used even if you upgrade ICON-NMR at a later stage.

ICON-NMR will not show any domain accounts after this change has been made.
1.9.3 Prevent ICON-NMR from attempting to change file permissions/ Avoid problems when saving in Configuration Window

To further improve the response times in very large domains, you may also prevent ICON from attempting to change the permissions of files (Configuration/Data Sets) after their creation. This change is also made by making an entry in the _iconnmrrc file residing in the home directory of the user who starts ICON-NMR.

```
set CHANGE_FILE_PERMISSIONS no
```

If you’re not sure what you’re home directory is, close ICON-NMR and restart it with the command ‘icon info’ in TopSpin. Your home directory will be displayed in an additional window.

Configuration files and data directories will thereafter be saved with permissions which may not be secure and the Umask setting in Configuration->User Manager will not be taken into account.

Set the permissions of files/directories in the TOPSPINHOME/conf/instr/<Instrument>/inmrusers as you require.

Should you still have problems get in touch with nmr-software-support@bruker.de

1.9.4 Other Useful features configurable via _iconnmrrc

The following is a list of other items which are not accessible in the configuration window, but which may be changed by making an set entry line in the _iconnmrrc file as in the example described above.

**TOJDX_PROGRAM**
Default value “tojdx”, Optional setting “tojdx5”

This option allows the old style tojdx program (tojdx5, 1D only version) to be used in ICON-NMR.

**EXIT_PERMISSION_CHECK_FROM_AUTOMATION_WINDOW**
Default value “no”, Optional Value “yes”

This option when set to yes prevents users without the User Manager exit permission from closing the Automation window. Normally this check only occurs when attempting to close ICON-NMR.

**JUMP_TO_NEXT_SAMPLE**
Default value “no”, Optional value “yes”

This option forces ICON Automation to only execute one experiment per sample before jumping to the next sample (if any). If only one sample has been submitted this implies that the sample would be inserted and removed (provided the eject last sample flag is set). This mode may be interesting for reproducibility studies.
Chapter 2
The Main Desktop

2.1 Overview

After starting ICON-NMR using one of the procedures described in the Introduction chapter of the manual, the ICON-NMR main desktop will appear, showing the icons in Figure 2.1 as command buttons. The following sections present a short description of the assigned functions. Every function will be discussed in detail in the following chapters of this manual.

![Figure 2.1 Icons of the main desktop](image)

The main desktop may cover the entire monitor screen, shielding the user from the other windows active on the workstation. The desktop has a window manager...
frame, which may be removed via the Supervisor permission, making it impossible to move it aside and access other programs. Should this default setting be too restrictive for a particular user, the laboratory manager can add a window manager frame to the desktop by activating the Supervisor permission at ICON-NMR’s Configuration -> User Manager page.

You can, of course, reduce the size of the initial window so that it only contains the 4 main start buttons as shown in Figure 2.1. ICON-NMR 4.1 retains the size information for future use.

2.1.1 Routine spectroscopy

This ICON-NMR mode was designed to help the user perform standard experiments (provided by Bruker or set up by the laboratory manager) by simply following the steps:

- Insertion of the sample into the magnet (manually, no sample changer)
- Defining a file name
- Defining the solvent
- Defining the experiment
- Starting execution

If not configured differently by the laboratory manager, experiment execution consists of data acquisition, processing and plotting.

Any experiment will generate an entry in a protocol file, which can be for user accounting in the System Manager Accounting program.

2.1.2 Automation

This is the advanced extension of Routine Spectroscopy for spectrometers equipped with/without a sample changer. It may be used in a manual mode without a sample changer as an alternative to the simple Routine Spectroscopy interface. It is easy to use, has direct access to locking shimming routines, includes features for dealing with sample priority, and is open-access for multi-user walk-up usage.

2.1.3 Toolbox

The ICON-NMR Toolbox is a user-configurable graphical interface providing an experiment oriented template setup which interfaces seamlessly with ICON-NMR’s
 Automation front-end. These templates may be re-used or exchanged depending on the spectroscopic task at hand. All the features of ICON-NMR’s Automation window remain active and fully accessible. With the Toolbox though, such things as default parameter values, locking and shimming routines, acquisition and processing commands may be set on an experiment dependent basis. Parameter values may be inherited from or bequeathed to other experiments or set globally for all experiments on a particular sample or all samples. See the online manual for more information.

2.1.3.1 NMR Biotools

This is a simplified front end to the ICON-NMR Toolbox and after some initial splash screens acquiring general information on the Protein/Protein Ligand to be investigated, guides the user into an Application Specific tree of suitable experiments together with their parameters for measurement under Automation control. No previous experience of the Toolbox software is required. This simplified interface is available through the biotools TOPSPIN command or the Spectrometer menu inside Topspin.

2.1.4 Configuration

Here you may define experiments and user specific properties of the program interface. The Configuration interface consists of a browser style interface with logical pages of configuration information pertaining to the program.

2.1.5 Help

The Help menu allows you to access this ICON-NMR manual on line.
Chapter 3
Automation

3.1 Entering Automation mode

Enter Automation mode by clicking on the respective icon of the ICON-NMR main desktop. A identification window will invite you to identify yourself. To return to the main ICON-NMR desktop click on the Exit button of the File menu.

3.1.1 User identification

See “User identification” on page 121 for more details on identification requirements.

3.2 The Automation Setup Window layout

After successful user identification, the user interface shown in Figure 3.1 will appear on the ICON-NMR desktop showing an array of sample holders. The size of the array will depend on what type of sample changing mechanism you have installed on your instrument see ’Default Number of Sample Holders The number of samples to be shown in the experiment manager window can be set here.’ on page 100. The setup window shows all samples and their respective status in the system, Available, Queued, running completed or error. You’ll find control buttons
to add/change/delete experiments from the setup window experiment list, a history list giving information on what the instrument actually did and various other control buttons.

The setup window is the Automation control center. It is the master scheduler for the instrument. It consists of the following items:

- **The window manager bar showing the directory where the automation information is to be temporarily stored.**
  This is allocated afresh each time the Automation program is started. A directory is formed based on the time/date the program was started on and the username of the operator who started the program. This directory is used for temporary purposes only and, if the setup is not explicitly saved, it will be deleted when the program exits. The directory resides in TOPSPINHOME/prog/curdir/changer/inmrchanger.

- **The main menu bar with pull down menus for Automation operation.**
  Most of the commands in the commands in this menu may be accessed quickly using keyboard accelerators. For example <Alt-f, c> closes the automation setup window. This is the same as clicking with the mouse on the File->Close menubutton. The setup window is designed to be suitable for keyboard or mouse interactions at all times. That way you can speedily set up new experiments without having to jump back and forth between keyboard and mouse operation. See “Using the mouse or the keyboard” on page 14.

- **The setup Icon-Bar.**
  These are buttons exclusively for mouse use to quickly access basic setup window features, e.g. Start/Stop Automation, show the sample holder overview, show more detailed experiment information etc.

- **The experiment display area consisting of a hierarchical listbox of experiment entries**
  Hierarchical simply describes the way in which the three levels of information shown in the listbox are stacked above each other. At the top are the sample holders, then come the experiments followed by any reference experiment information, Figure 3.1 Holder 11 is at the top or the hierarchy. It has 2 experiments (shown by the type icon). These 2 experiments are lower down in the hierarchy, they belong to holder 11, the COSY experiment having a reference spectrum information line which is at the bottom of the hierarchy, it belongs to the COSY experiment. Double clicking on a list entry folds it up or down to
3.2 The Automation Setup Window layout

reveal information already entered or entry boxes for addition of further experiments.

- **The experiment queue control buttons**
  The buttons in the center of the setup window always apply to selected entries (marked in blue) in the experiment listbox area. Use them to submit experiments to the queue, remove experiments from the queue, edit previously cancelled experiments, delete experiments or for addition/copying of experiment information. Their operation will be described in detail later.

![Automation Setup Window](image.png)

**Figure 3.1 Automation Setup Window**

- **A Preceding (history) Experiments box with details of experiments performed**
  Here you'll find detailed information on completed experiments no longer in the queue. The most recently performed experiments will appear here. The various stages of acquisition are shown: ATM (automatic tuning/matching), rotation, lock, shim, acquisition and processing. Successfully completed stages are shown with a tick whereas stages where any problems were encountered are marked in red with an ‘x’.
Features:

- Double clicking on an entry will open TopSpin or the Amix-Viewer program in the respective data set. The viewer may be configured via Options->Configuration->Automation Window.
- Individual Columns may be moved as required. The new positions are recorded for the next run.
- Double Clicking on a column heading border sets the column width to the width of the largest text item in that column.

Right clicking on an entry opens a menu with further options.

**Note:**

More detailed information on what the Instrument actually did may be attained by using the TopSpin history feature. Type hist in TopSpin to see a time stamped list of all actions performed. Files containing all automation commands are then stored in TOPSPINHOME/prog/curdir/<user who started Topspin>/history. The previous TopSpin history information is stored in the file history.old.

Search Preceding

In ICON-NMR 4.2 it is possible to search through all experiments previously performed by Icon-NMR for a particular text. Text may be quoted in inverted commas to search for an exact string, or if it is not quoted, the program will search for an entry containing all of the given text items.

This feature may be disabled via the Configuration->Automation Window->Display->Enable Search Preceding.

Once you’ve come to grips with the overall layout of the setup window the next step is to actually perform some experiments.

### 3.3 Automation Quick Start Guide

Here you’ll find all you need to know to get the automation up and running a.s.a.p.

#### 3.3.1 First steps in ICON-NMR Automation

As is the case for Routine Spectroscopy Mode the TopSpin software must be installed and configured correctly before commencing automation. See “TopSpin configuration” on page 12 for more details and use the integrated “Setup Manual”
To get your first automation run underway proceed as follows:

1. Start ICON-NMR from the Windows->ICON-NMR pull down in TopSpin.

2. Click on the Automation Icon.

3. Identify yourself to the system. If you do not see your user id in the identify user window, you or the laboratory manager should save a user file using the User Manager from the Options->Configuration Menu. See “User Manager” on page 81 for more details.

4. Once you’ve successfully logged in, the Automation setup window should appear containing the appropriate number of sample holders. If you see the incorrect number of holders in the setup window in the Holders column then set the number of default holders using the Configuration Manager->Automation Window->Display->Default Number of Sample Holders. This will be especially necessary in Manual, NMR Case, Sixpack and MAS automation modes.

See “Default Number of Sample Holders The number of samples to be shown in the experiment manager window can be set here.” on page 100 for more details.

5. Choose the particular autosampler location you’re interested in and
   a) Double click with the left mouse button on the holder or
   b) Click on the holder and use the Add button <Alt - a>.

6. Once you’ve set the experiment details, use the Submit button to indicate that it may be measured.
   After an experiment has been submitted you may no longer make modifications to it. Should you wish to change something then you should first Cancel the experiment, then Edit it and finally Submit it again.

7. You may add further experiments on that sample with the Add button as required.

8. Click on the Go “cogwheel” icon to start the run. The program may also be configured to start the run automatically. See “Configuration Options” on page 79.
3.4 Component Descriptions

3.4.1 The experiment entries

Each sample holder line in the setup window consists of 13 (in BEST NMR 14) columns of information classified as follows:

1. **Holder**
   A little triangular symbol and number indicate the current holder. The triangle shows whether individual experiments are displayed or not.

2. **Type**
   Shows whether a holder line has any information and if so displays the number of experiments defined for that holder. An empty tube icon depicts an empty holder. To add an experiment to an empty holder either
   a) Double click on it or
   b) Hit Return on the anchored\(^1\) entry.

3. **Status**
   This may be configured to show traffic lights in two different modes or text. The mode can be changed by using the Configuration user interface. See “Configuration Options” on page 79. The following experiment states are currently supported:
   - Inactive
   - Submitted to Queue
   - Running
   - Completed
   - Error

4. **Disk**
   Disk directory where experiment is to be stored. User selectable or definable form the User Manager See “The Data Directories box” on page 92. The system may thus be configured to allocate the disk partition automatically.

5. **Name**

---

1. This is the entry with a dotted line border. May be moved by mouse clicking on another entry or by using the keyboard accelerators \(<Alt + z>\) for up and \(<Alt + x>\) for down.
Name of experiment. This may be entered by the operator or defined to be set automatically from the User Manager. See “The Sample Names box” on page 87. The system may thus be configured to allocate the name automatically.

6. **Exp No**
   Experiment number to be used for this entry. This will automatically be allocated to the next free experiment number based on the current user and the disk and name the user has chosen. If the operator has the Data Set Edit permission he may allocate the experiment number himself.

7. **Solvent**
   The solvent may be set up here as defined at TOPSPIN configuration time by the `edsolv` command. Changing the solvent for any component experiment of a holder changes all other solvents for non-submitted experiments automatically.

8. **Experiment**
   Here the operator may choose the experiment from his pre-defined list. This list is defined with the User Manager. See “The Experiment List box” on page 82. The experiment type, name and comment are given here. There are presently two types of experiment normal (single) N or n and composite C or c. Lower case characters imply that the experiment will be forced to run in the low priority “night-time” mode. If a composite experiment is chosen then new experiment entries will be added as required for all components of the composite experiment.

9. **Structure/Processing**
   When this feature has been enabled in the Master Switches->Processing Control section of the Configuration window, a Mol/SD file may be set which will be used on HSQC experiments to perform an automated structure consistency check. This feature requires the Perch Software Tools.

10. **Method**
    This column is only available if the program has been configured to run in BEST mode. Depending on the chosen solvent the corresponding methods as defined in `bestadm` Methods will appear in the pulldown menu. This information used not be sample dependent, but now that the BEST utility has the capability of changing solvents the introduction of a solvent specific method, makes the system even more flexible.

11. **Par**
This column currently consists of 2 buttons controlling the User Specific Parameters and the Lock/Shim/ATM settings for the individual probe/experiment respectively.

User Specific parameters may be accessed directly from this column, provided they have been defined for the respective user, see Figure 5.2.1.11. Changes in this window will be copied to all copied entries. If the Modify Lock/Shim/ATM permission has been set in the User Manager, then the current settings for Lock, Shim as well as the experiment dependent ATM mode may be altered as necessary.

The Lock options is treated on a holder basis and not on an experiment basis. The Shim option may be set up such that it is possible to shim on every experiment. For this option set the “Shim the sample” option in the configuration window’s Shimming Controls page to “on every experiment”.

12. Title
The title icon when activated pop’s up a text entry box which may be used to enter a specific title for later plotting. Originator information items (if activated) are also to be entered here. See “The Originator Items Editor” on page 95. The title information will automatically be copied to all other experiments added on a particular sample. The title icon changes after text has been entered. Use the Set & Copy Title button to force all other title entries (those on-edit for the current sample) to set their entries to the same values as the current title box.
13. **Priority**

Users who have this option enabled in their user permissions file may decide to prioritize certain experiments. Such experiments will then be run before non-prioritized experiments. The priority will be based on the time of their submission. Such experiments will either be run after the current experiment is completed or when all experiments scheduled on the current holder have been completed. For more details see 'Priority Options' on page 113. ICON-NMR also has a Day/Night mode which may be used to ensure that time consuming experiments are always run at night. Click on the Sun icon and it will toggle to a moon icon, this will classify the experiment as lower (night-time) priority. Note the day night mode applies to experiments. If you want the sample to be measured at night you must mark all its experiments as being “night” experiments. If you’d like to run one experiment during the day and another at night then simply mark one as day and one as night.

14. **Time**

The experiment time (estimated acquisition time) is calculated each time an experiment is submitted and also after any parameter editor has been used. This feature may be deactivated to save some processor overhead.

15. **User**

The user who entered the experiment on the experiment list is denoted in column 12. Note: Experiments belonging to other users may not normally be copied, deleted or altered in any way. If you want to have complete access to other users experiments, change user to the nmr super user.

### 3.4.2 Queue Control buttons

You'll find an array of queue control buttons in the centre of the Setup Window:

All of the following buttons apply to the selected holder/experiments. Selected experiments have a light blue background to distinguish them. If only the holder is selected (no experiment information selected) then the button’s function will be carried out on all of the experiments in that holder. Of course you can also mark particular experiments.

- **Submit <Alt + s>**
  
  Submit generates all data necessary for the experiment, calculates the experiment time and sets the status of the experiment to ready. If the run is active the experiment will be found and executed. Submitting an experiment removes the editable boxes and substitutes them with fixed text elements which may no
longer be edited. You may only submit an experiment if all the required information required to start the experiment is available.

- **Cancel <Alt + c>**
  All of the selected experiments will be effectively removed from the queue. This button is useful together with the edit button if you want to make changes to the experiment before run-time. Note you can always re-submit a cancelled experiment, the information content will not be removed. The experiment is merely ‘deactivated’.

- **Edit <Alt + e>**
  This button re-inserts the editable boxes on an experiment entry. These may then be edited in the usual manner. Use in conjunction with the cancel button to change previously submitted experiments. Click on the edit button again to remove the edit boxes.

- **Delete <Alt + d>**
  Removes all experiment information from the display and from the queue. Does not remove any spectral information from the target or archive disk. As mentioned above to remove all experiments on any sample holder mark the sample holder the entry where the holder number is indicated. To remove a single experiment select that experiment only.

- **Add <Alt + a>**
  To add an experiment to a holder with none (empty tube icon) double click on the holder or use the Enter key (once the holder has the anchor. See “Hit Return on the anchored entry.” on page 28). If the holder already has at least one experiment use the Add button to create more experiments on that holder. The spin box to the right of the Add button determines the number of experiment lines to be added. These lines will automatically receive a valid disk, name, experiment number, solvent and title entry. The only information you have to enter is the experiment type.
• **Copy**

There are several methods of copying a holder's experiments to another holder:

a) **Sequential**

All experiments on a particular holder are copied to the next (empty) \( N \) holders. This is the default method. Proceed by selecting the holder you wish to copy. Use the spin widget to the right of the *Copy* button to set the required number of copies. All experiments will be copied to the next \( N \) holders in the display area. The expno is incremented to the next free expno which is a multiple of 10. Should you wish to keep the same experiment numbers and increment the Name of the experiment; e.g. Jan-19.001, Jan-19.002 set the *Holder-*> *Increment Name* menu entry before copying. The experiment number will, in this case remain constant.

b) **Targeted**

The selected holder’s experiments are copied to every other selected holder. This method is automatically selected if more than one holder has been selected (blue background). The selected holder’s experiments are copied to all other selected holders. The same numbering strategy is applied as in the sequential case.

When the copy routine gets to the end of the setup window the copy is wrapped around to the beginning of the table.

c) **Multiple Source Holder Copy**

You may copy experiments from multiple sequential holders in one single copy action. Simply select with the control key depressed all the holders you wish to copy, and finally the target holder. The target holder should not contain any experiments. Then activate the Copy button.

d) **Duplicate Experiments on a single Sample. (Experiment Iteration)**

Should the same experiments be run multiple times on a single sample the *Iterate* menu button may be used to create copies of all experiments which have already been set up, together with their parameter values and settings. Click with the right mouse button on a holder or its experiments and choose Iterate. Use the spin widget to the right of the main Copy button to determine how often the experiments already present are to be repeated.
• Change User

Click on this icon should you wish to login/logoff the system. The login user determines what experiments and environment the operator will have. The border color of this icon turns red when no user is currently logged in. You may also click on this Icon to lock ICON-NMR. When ICON-NMR is in the locked mode no changes may be made to the current setup. It is also impossible to leave the program. If you want to alter Experiments entered by other users login as the NMR super user.

3.4.3 Setup Window Icon Bar

The following icons appear under the menu bar and may be used to access particular features with the mouse.

The Automation ‘Go’ button

This button is responsible for starting the run. It has the same effect as the Run->New Run menu command. Once activated a popup dialog will appear as shown in Figure 3.2.

![Figure 3.2 Initialize Run Dialog](image-url)

The Initialize Run Dialog is displayed each time the run is started, unless the Laboratory manager has configured the system to start the run automatically at start up.
3.4 Component Descriptions

The time. See “Automation Driver Engine” on page 102.

The Acquisition Type field refers to the type of sample changer Driver which is to be used in the system, BACS, SampleJet, BEST, Sixpack, NMR Case MAS, LCNMR SampleTrack or Manual mode (no sample changer). These drivers are TCL/TK scripts and may be adapted to suit your own environment. You’ll find them in:

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/Automation/driver_lib

Drivers

Driver files have the extension .drv, there’s also a file drivers which is used to tie a comment to a particular driver file. This comments appear in the Initialize Run window.

The First Sample entry tells the system where to start, i.e. which holder will be run first. With the ‘First sample in the magnet (locked and shimmed)’ it’s possible to tell the system to skip the locking and shimming routines for the first sample.

As a further option you may instruct ICON-NMR to skip the processing on all the experiments it performs. This question may be deactivated from the ICON-NMR Configuration window.

**The Automation ‘Pause’ button**

Use this button to pause the acquisition. This action will take effect after the current running experiment has been completed. For BEST-NMR this will also bring the system into a well defined state and cause barcodes to be scanned, if this option has been configured.

**The Automation ‘Play’ button**

As you might expect, the play button sets the Run in motion again.

**The Automation ‘Stop’ button**

This cancels the current run. It will also stop the currently running experiment. If
you wish to stop the run without interfering with the currently running experiment use the pause button instead. All experiments which have not yet been completed remain in the queue and are still available for running at a later date. The Stop permission is user specific, only the user who started the run or the NMR Super user (password required) may stop it.

**The Sample Holder Overview**

Use this button to call up the window shown in Figure 3.3. This window lets you see at a glance what the sample changer has been up to during the automation. It shows all sample holders in a grid array. As in the history list if an error occurs on any sample an ‘x’ appears in that particular holder.

The sample holder overview may also be used to position the setup display at a particular entry. Just click on the holder you’re interested in. You can even open an entry on a previously unused holder by double clicking on it. You’ll also notice that holders in the overview status may be selected in the same way as the holders in the setup window. Click on the first holder you wish to mark and drag the mouse. All following sample holders will be selected (marked in blue) in both the overview and setup window. If you wish to select holders, which are not marked sequentially (e.g. for a targeted copy), hold down the Ctrl button before clicking on the particular sample holders. Don’t forget to select the ‘source’ holder for the targeted copy as the last element to make sure it’s the anchored entry.

![Sample Holder Overview](image)

*Figure 3.3 Sample Holder Overview*
3.5 Menu Bar commands

Acquisition Controls Window

This button displays the Automation Control window, provided it has been enabled in the view menu. The button acts as a toggle. If the window is not viewable it will appear. If the controls window is on the display, clicking on this will remove it.

3.5 Menu Bar commands

3.5.1 The File Menu

The file menu contains the following items:

- **New**

You may start a second experiment setup window and setup further experiments to be run at a later date.

- **Open**

Open reads in a previously saved experiment setup into the current setup window. The history information is also loaded.

- **Save**

If you’re going to perform all the experiments again it might be a good idea to save a copy of all the experiment information stored in the setup. The ‘Save’ button will do this for you. It saves all the data in an ASCII format which can easily be retrieved or modified using any text editor. The save button will save this file in the directory TOPSPINHOME/prog/curdir/changer/<setup directory name>.set

ICON-NMR saves this file automatically for you.

- **Save as external setup**

  This option may be used to generate an external setup file based on the contents of the setup window. In general this option is not required, it may be perhaps of interest in cases where barcodes are going to be used.

- **Print (List Setup)**
This prints a copy of the Setup file in an easy to read format on the default printer. On Windows NT the notepad program is used to print the file. Use the Edit->Set Font switch to change the font (if necessary).

- **Print History File**

Prints the history information at the bottom of the setup window to the default printer. On NT you may have to set the default font for the notepad program to obtain reasonable results. Should you have problems the file may be printed directly from the prog/curdir/changer/inmrchanger directory.

- **Close**

Closes the setup window and returns to the Identify User mode.

- **Close All**

Use the close all when you wish to close several setup windows in one sweep.

### 3.5.2 The Run Menu

These menu items may be used in the same manner as those already described in section 3.4.3.

The following entries are also available:

- **Manual Lock/Shim**

  This option may be activated during the run to cause the manual Lock/Shim window to appear at the appropriate time during the run. Activation is linked to the User Manager Manual Lock/Shim check button described in section 5.2.1.5

  This window, as the name implies, allows the user to lock shim via the bsms keyboard or the bsmsdisp window. When this window appears a timer is started and automation continues after a time limit of 10 minutes. After the 10 minutes have elapsed a warning is displayed. The user then has the option of extending the lock/shim period by a further 10 minutes.

### 3.5.3 The Holder Menu

- **Selection Menu buttons**

  Items in the upper half of the holder menu may be used to quickly select several items at once. For example you may wish to cancel all successfully completed
experiments in one swoop and then delete them. In this case you’d use the 
*Holder->Select Completed* menu option, followed by the *Cancel* button and *Delete* 
button.

**Copy Mode**

Here you can decide how ICON-NMR Automation is to copy experiments. *Increment Expno* is the default setting and should be optimal for most purposes. Here 
any number of experiments will be copied. The system checks and automatically 
allocates sensible experiment numbers, while keeping the current Name setup.

The ‘*Increment Name*’ mode keeps the same current experiment numbers while 
adding numbered extensions to the name to make new unique data set names.

### 3.5.4 View and Find menus

These contain various menu buttons which control which elements of the setup 
window are to be shown. You may use them to improve the clarity of all display 
information. The find pull down helps you quickly find particular types of entries. 
This may be useful if in certain circumstances you have so many entries that you 
can’t see the wood for the trees.

### 3.5.5 Parameter Menu

As in Routine Spectroscopy mode you can use the parameter menu buttons to 
access any of the parameter editors which TopSpin has to offer. If the laboratory 
manager has configured the operator so that he/she can execute specific com-
mands, e.g. lockdisp then these will also appear in the *User Specific Commands* 
pull-down. See “User Specific Parameters/Commands” on page 93. These buttons 
apply to the entries in the setup window which have been selected.

Note: Should you accidently hit Edit Parameters when multiple experiment entries 
have been selected which you do not wish to edit/view, you may cancel the opera-
tion by hitting the Esc key while the keyboard input focus is in the setup window.

### 3.5.6 Tools Menu

- **Import an Experiment/Data Set**
  
  Use this dialog to grab the current data set on display in TopSpin and set it up 
  for measurement on any particular holder inside ICON-NMR. This may be done 
  without the usual intermediate step of updating/creating a parameter set and
setting it up for use within ICON-NMR via the User Manager. The data set is copied into the setup window and will be measured with the Solvent, Disk, Data Set Name and Expno as defined in the dialog window.
Use the ‘Refresh’ button if the data set shown inside TopSpin was updated.
After the data set has been imported it may be modified, copied, iterated or prioritized as would normally be done with any standard ICON-NMR experiment.

• Run an experiment Periodically (Kinetics)
Have any experiment repeated automatically any number of times on a particular sample with a specific time delay between experiments. Up to 10 such periodic measurements may run simultaneously, so different experiments could be programmed to run multiple times on different samples.
Experiments submitted in this way have their priority flag automatically set.
This feature may be enabled/disabled by enabling/disabling the Automation Window on the Configuration->

3.5.7 Best Menu
This is only present if ICON is running in BEST mode.
Show BEST Monitor causes the BEST driver to display its debug window showing all commands sent to the Gilson Liquid Handler, replies and other information.
Show provided solvents displays the BEST solvent editor’s provided solvents page, normally accessible from the bestadm TopSpin command. On start-up BEST may require that you use this window to set the correct port for a specific solvent or set the solvent for a particular wash rack.

3.6 Automation Window Tips
Here are some features of the Automation window which may not otherwise be apparent.
• Click right on the setup part of the automation window to Submit, Cancel...etc.
• To raise TopSpin or the Amix-Viewer in any previously measured data set, double click on the corresponding entry in the history (lower) part of the setup window
• Use Alt-x and Alt-z to move the selection anchor up and down in the setup list
• Use Ctrl-Tab to move the focus out of the title window
3.7 External Setup

You can change the width of individual columns in the setup window by dragging the mouse with the left mouse button depressed on any column header border.

- The Delete Key deletes marked experiment setup entries.
- The Insert key adds an entry at the anchor position.
- The Esc (Escape) Key breaks out of any loop action; e.g., Copying, Submitting, Deleting or parameter modification of multiple entries.

3.7 External Setup

The Automation module of ICON-NMR may be used in external setup mode. This means that all the submitted entries are inserted into the setup window for processing without the need for any direct keyboard input to the setup window.

The entries are created via an ASCII file which must be copied to the TOPSPINHOME/prog/tmp directory. ICON-NMR Automation scans this directory periodically (every 10 seconds) for new “setup” files. All you need to do is logon to the ICON-NMR Automation software as any valid user.

This directory should be made writable for all those TOPSPIN users who will be starting the run/copying the files, if external setup mode is to be used. The format of this file is exactly the same as it was for the set/run Automation routines.

Here is an excerpt from the TopSpin manual on external setup:

3.7.1 Acquisition parameter setup with extset

Laboratories often employ a centralized sample management, which requires that the experiments are not defined locally on the NMR spectrometer with ICON-NMR, but rather on PCs or a central laboratory computer, from where they must be transferred into the spectrometer via the network or via magnetic storage media. ICON-NMR offers the following means for accomplishing such tasks:

The experiments for each sample may be defined in a text file in ASCII format, e.g. on a remote computer. If ICON-NMR should execute such an experiment, the file must be copied into the directory TOPSPINHOME/prog/tmp/ of the spectrometer computer (e.g. using rcp or ftp in an Ethernet network).
ICON-NMR periodically (every 10 seconds) checks the directory TOPSPINHOME/ prog/tmp/ for new ASCII experiment files. Any new file will automatically be inserted into the desired setup window. The result is the same as if the user had entered the information directly on the spectrometer.

Once entered into the setup file, the ASCII file is deleted from the temporary directory TOPSPINHOME/prog/tmp/. It is therefore the user's responsibility to keep a backup copy of this file, if at all. If several ASCII experiment files are found by extset, they are processed in the order of their file name extensions NNN.

An experiment is defined by the keywords HOLDER, NAME, EXPNO, SOLVENT, PARAMETERS, EXPERIMENT, TITLE.

They correspond exactly to the fields of the ICON-NMR setup window. NAME, EXPNO, and TITLE are optional, i.e. they may be omitted. In that case ICON-NMR uses standard default values: EXPNO=10; no title; NAME is formed from the name of the experiment file, the extension being replaced by the HOLDER number. Only experiments of type N (no preparation experiments required) or C (composite experiments) are allowed.

Note that after the EXPERIMENT keyword only a TITLE keyword may be accepted, any other keyword will force the experiment to be submitted with the current disk, name, solvent, user, expno values.

Figure 3.4 illustrates the main Keywords used in ASCII experiment files. Lines starting with the character # are comment lines, which are ignored. The file consists of a series of keywords (one per line) combined with information.

Features
1. No limit to the number of experiments per holder.
2. The first experiment on a holder can be a composite experiment.
3. Each experiment can have an individual title. Titles can have more than one line. The line separator is the \n sequence. If several experiments are defined for one holder, each experiment can have an individual name (NAME) and experiment number (EXPNO).

When ICON-NMR sees a new extset file it will normally read all the information in it and enter the experiments in the setup and submit them. If you do not wish the created entries to be submitted then you should include the Keyword NO_SUBMIT in your extset file before the EXPERIMENT keyword line. With the Keyword SUBMIT_HOLDER you can submit all experiments for a particular
holder at a later stage. The SUBMIT_HOLDER keyword requires a preceding HOLDER keyword to be recognized.

There are also new keywords DELETE and PRIORITY which may be used to delete all experiments for a given holder and to set the Priority flag for a given experiment respectively.

The new macro PARAMETERS allows for external parameter modification of the data sets generated for Automation.
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Comment line</td>
</tr>
<tr>
<td>USER</td>
<td>data set USER parameter</td>
</tr>
<tr>
<td>HOLDER</td>
<td>Holder number to be used</td>
</tr>
<tr>
<td>NAME</td>
<td>data set NAME parameter (optional)</td>
</tr>
<tr>
<td>EXPNO</td>
<td>data set EXPNO parameter (optional)</td>
</tr>
<tr>
<td>SOLVENT</td>
<td>solvent name</td>
</tr>
<tr>
<td>EXPERIMENT</td>
<td>experiment name (of type N or C)</td>
</tr>
<tr>
<td>METHOD</td>
<td>method name (e.g. methodname user (for BEST))</td>
</tr>
<tr>
<td>TITLE</td>
<td>rest of line is the plot title (optional)</td>
</tr>
<tr>
<td>DELETE</td>
<td>deletes all experiments for a holder</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>comma separated list of parameters and their values for modification (optional)</td>
</tr>
<tr>
<td>PRIORITY</td>
<td>enables the priority flag for this experiment</td>
</tr>
<tr>
<td>NO_SUBMIT</td>
<td>the entry will appear in the setup list but will not be submitted</td>
</tr>
<tr>
<td>SUBMIT_HOLDER</td>
<td>all entries for the defined holder will be submitted, no new entries are created</td>
</tr>
<tr>
<td>END</td>
<td>end of holder definitions section</td>
</tr>
</tbody>
</table>

**Figure 3.4** Keywords used in Ext Set files
The following example ASCII text file summarizes the ext set file features:

```
# in 1. column means: comment
USER eng
HOLDER 8
#
NAME June15
EXPNO 10
SOLVENT CDC13
PARAMETERS ns,1,td,1024
EXPERIMENT sw_cosy45
TITLE This is a title\nwith two lines
TITLE This is a second title for the first exp. of the comp.
TITLE This is a third title for the second exp. of the comp.
NAME June16
EXPERIMENT PROTON
TITLE This is a title\nwith two lines
EXPERIMENT C13CPD
TITLE This is a title\nwith three lines\nThird line
#
HOLDER 9
NAME June17
PRIORITY
SOLVENT CDC13
EXPERIMENT PROTON
TITLE This is a default title
EXPERIMENT C13CPD
TITLE This is a default title
EXPERIMENT C13DEPT45
TITLE This is a default title
#The next two lines delete all experiments for holder 10
HOLDER 10
DELETE
# Only one END statement per complete file!
END
```
3.7.2 Spreadsheet Import

ICON-NMR also has a facility to load all its experiments from a file which may have been generated by a spreadsheet program, Excel, Open Office, etc.

For this it is first necessary to make a Comma Separated Value file from the spreadsheet. This is usually accomplished via the File->Save As feature of the spreadsheet program. The file may then be imported directly into ICON-NMR Automation via the File->Import Spreadsheet .csv file menu entry.

After selecting the .csv file containing the spreadsheet information, the next step is to define what actually lands in the current setup window.

3.7.2.1 Comma Separated Value Import Dialog

As may be seen in Figure 3.5, users have access to all the standard settings available in the Setup Window, as well as to the individual columns from the .csv file.

3.7.2.2 What information may be extracted

Any single column of information may be used to supply the following information:

- Disk, Data Set Name, Solvent, Holder Position, BEST-NMR Method, Experiment and a MOL/SD File.

This is achieved by using the [COL_X] notation, where X is any column A through Z and following that AA, AB, AC...BA, BB, BC...to ZZ. As may be seen in the figures “Disk” entry, an item of fixed text may be combined together with a column to produce the necessary entry.

The title may be composed of multiple columns of information. It is imported and converted into originator items which will then be shown individually should the title be edited. This originator information will appear in the title according to the rules governing originator information as defined in Configuration->User Settings->Originator Items->Automation Mode Options

3.7.2.3 Assumptions about the .csv file:

The very first row contains the names of the respective columns
The names of the individual columns are thus available to the software and will be displayed where defined in the orig/title files.

3.7.2.4 Controlling the import process

Experiments are loaded sequentially on a row by row basis from the .csv file. One row position from the file corresponds to one holder in the setup window. To circumvent this and have multiple experiments on one sample, define the holder information to also be taken from a column in the CSV file.

You may also use a Composite Experiment if the holder position is not to be taken from the CSV file.

The following items regarding the import may be set at import time:

![CSV Comma Separated Value Import Dialog](image)

**Figure 3.5 CSV Comma Separated Value Import Dialog**
• Begin at Holder Position
  The first holder position to be imported may be specified. The rows from the .csv file following that will be entered in the following rows of the setup window. A column from the CSV file may also be used to set the holder entry for any experiment according to its CSV holder definition.

• Begin at CSV File Row
  Normally the import begins immediately following the 1st row of information, here you may define which row from the csv file is taken first.

• Stop at CSV File Row
  In long .csv files use this to determine where the software should stop importing information. If the value ‘last’ is used, the interface will import the all the data from the file up to and including the last row.

3.7.2.5 Adaptation to suit your exact requirements.

The source code for the import procedure is available and may be adapted where this is necessary to suit your own needs. The code is written in TCL and may be found in:

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/Automation/lib/
Auto_UserCustomizableCode.tcl


3.8 WEB Interface

ICON-NMR 4.2 contains an embedded web server, meaning that access to all the automation information including spectral data via pdf files is possible from any web browser, provided the spectrometer workstation is available on a company Intranet. If the company firewall is then configured to allow external access from the Internet, automation control and monitoring will be possible from any internet access point.

In addition, today’s modern Personal Digital Assistants (PDA’s) screen format is also supported, so that in theory it is possible to control the complete automation run and by inference the NMR Spectrometer from a mobile phone or Pocket PC. User control is managed in the same fashion as in the ICON-NMR Automation interface itself. Multiple users may of course be simultaneously logged in to ICON. All input/output runs over the main Automation window back at the Spectrometer workstation.

No additional software is necessary and control has been tested over a 56k modem (with BACS Automation) without overstretching the modem bandwidth.

3.8.1 Features:

- Remote Experiment Submission/Cancel/Deletion with full control over:
  - Title/Originator Items
  - User Specific Parameters
  - Priority/Night Settings
  - Lock/Shim/Automatic Tuning and Matching Options
  - BEST Method

  Experiment editing now possible

- NMR Administrator may remotely start/stop/pause the automation run
- All Setup and History fields are visible.¹

¹ ATM/Lock Shim control not available via Pocket PC
3.8.2 Configuration

The Web Interface comes disabled out of the box and must be explicitly enabled via the ICON-NMR Configuration window. Click on the Automation Configuration->WEB Icon Interface page.

3.8.2.1 Enable Web Interface

If this is disabled the web server remains dormant in the current run. The web server may be enabled or disabled on the fly via the Configuration->File->Update Run Parameters menu entry.

3.8.2.2 Enable Standard Web Server

The standard http server will be enabled for use. Access it over the “Access Standard Web Server as follows”. This is the address used in your internet browser. In some instances it may be necessary to use a fully qualified network address to reach your Automation server. If in doubt contact your IT department.

3.8.2.3 Enable SSL Web Server

This enables the https server for use. SSL connections to the ICON Web server are encrypted for security and cannot be easily decoded. This is the standard used for transactions on the Internet. To use this service you must either supply a server certificate/key pair which will be used by the ICON-NMR server, or use the Make Certificate to generate a self-signed key pair. For use inside a company intranet, provided SSL is deemed necessary, a certificate should suffice. Once again contact your IT department if you require assistance/advice.

1. Must be configured by NMR Administrator
3.8 WEB Interface

3.8.2.4 Make Certificate

This opens a dialog window to grab information regarding the certificate. ICON generates certificates which are valid for two years. Users accessing the server will be warned that the certificate is unknown. The certificate may be installed on the remote computer (where the web browser is running) to circumvent this warning.

Note:
The common name of the certificate should be the name or IP Address of the workstation controlling the spectrometer. So for example if you use the address https://spectworkstation.chem.com/icon to reach the Web server then the common name which should be entered is spectworkstation.chem.com

This will ensure that the certificate matches the “site” of the actual web server. The name on the displayed certificate will also be shown as being valid. That way when remote users install the certificate they should not be prompted to verify the certificate again for the life of the certificate. And should another “fictitious” site be set up somewhere else and pose as ICON-NMR, then remote users will be alerted to that fact. (The certificate will be unknown)

The information supplied in the dialog is passed to the openssl program, delivered with TopSpin which will generate the 2 files in the directory shown below which represent the certificate key/pair.

3.8.2.5 Using Web Server Certificates from a certification authority

Certificates are stored in ICON-NMR’s web server program directory, i.e. TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/

Certificate file name: icon_server.pem
Key file name: icon_server_key.pem

Should you use a certificate/key pair generated by a certificate authority, you will need to install them in the above directory with the correct file names.

The certificate/key pair which are generated by the openssl program are generated with a particular passphrase. Should you use a externally generated keypair you
will have to set their own passphrase in the file
TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/options.iconnmr

Look for the TLS_PASSWORD line, remove the # at the start of the line and change the “secret” text to your password.

### 3.8.2.6 Allow all Icon Users

Use this in an environment where you do not wish to bother with passwords. In this case entering the username should be sufficient. Users which have been activated in ICON-NMR will be accepted and logged in without any password being checked.

**Figure 3.6 Make Certificate Dialog**
3.8 WEB Interface

3.8.2.7 Queue Interaction

New in ICON-NMR 4.1 is the ability to remove the Submit, Add, Cancel and Delete buttons from the webpage which clients display. When this queue interaction permission is denied, the history and setup portions of the page are visible, but no changes in the status of any holders are possible. In the PDA version the Action button is not available.

3.8.2.8 Web Users can view Spectra as PDF

This decides whether pdf files automatically generated by the TopSpin plot software should be available on the server for download. The “Always” setting implies that pdf spectral data will always be generated and any ICONweb user may download the pdf spectrum. If the “Only their own Spectra” mode is active then access will only be granted to the pdfs generated by the users own experiments.

In a running ICON-NMR, the software will only take notice of a change in the setting of this configuration option when the Configuration->File->Update Run Parameters

3.8.2.9 Individual Users/Passwords for Web Access

Define here which users are allowed access to the Automation Server. Only known ICON-NMR users may be cleared for web access.

3.8.3 Tips & Tricks

- Selecting multiple entries
  In Microsoft Windows Internet Explorer multiple sequential entries may be marked for submission. Click on the first experiment, then depress the shift key when clicking on the last element. All entries between the first and last will be marked.

- Reducing network data
  Customers wishing to reduce the size of the HTML pages being transferred may switch to the PDA (Personal Digital Assistant) version of the web pages. Prefix the /pda address to the URL when logging in. (Instead of using http://Computername:8015 use http://Computername:8015/pda)
Login in the usual fashion and use the pages links to view only the holders you are interested in.

- **Monitoring Web Traffic**
  The web server provides a /status URL which may be used to monitor network traffic to the ICON server. Log files with the name ICON_Web_log are also saved in the TopSpinhome/prog/curdir directory and are rotated.

### 3.9 Selective Experiments inside ICON-NMR Automation

ICON-NMR can run selective experiments based on region files created in previously acquired data sets. Such selective experiments operate in much the same manner as a composite experiment, in that they check their reference experiment for a region file, extract the limits from it and use them for acquisition purposes. Such selective experiments must contain the word selective in the USERA1 parameter and when, on Submit, this keyword is found, ICON will search for the region file in the reference experiment and enter the region limits in the SIGF1 and SIGF2 parameters. These values may then be used by the acquisition AU program.

Depending on how many selective experiments you have in your run on any given sample, each one will get sigf1 and sigf2 set to a different region.

Here is a summary of what has to be done:

Make a Composite with a preparation experiment and one or more follow-up selective experiments which reference the preparation experiment

Set in the selective experiment via wpar the parameter USERA1 to: selective (This lets ICON know its dealing with a selective experiment.)

Enter the composite in ICON's Automation window

Submit the prep experiment only.

When it has run, define the regions (make a reg file) with the regions to selectively excite. You may then submit the selective experiments (before the region file has been created submission is impossible). In each selective experiment ICON will set the sigf1 and sigf2 parameters automatically for each of the defined regions,
until no further regions are available.

Your AU program in the selective experiment will have to grab sigf1 and sigf2 and use them to determine the correct excitation information (pulse length, power, etc.).
Chapter 4

Toolbox Automation Extension

4.1 What is the ICON-NMR Toolbox?

The latest addition to the ICON-NMR group of programs, the ICON-NMR Toolbox, was included in the NMR-Suite 3.5 package. Why another interface? Up to now, automation was perhaps only seen as a method of optimizing the throughput of routine NMR measurements with emphasis on sample turnaround. But what happens if we're dealing with a small number of samples where an interchange of parameter information between multiple experiments plays a pivotal role. What if we need to deviate from the standard AU macros and parameter sets without creating a myriad of files which all basically do the same thing? You may have a picture in your mind about what you want your application to do, but you neither have the time nor the patience to implement an AU program to do it?

Here's where the ICON-NMR Toolbox comes in. With this little gadget, operators can quickly grasp a complex system whereby the nitty-gritty details of how it all works are neatly tidied up and where necessary concealed. Is this indeed possible without having to adapt standard Bruker AU macros or parameter sets? With the Toolbox we're confident that this will be increasingly the case!
4.1.1 Internal Structure

The ToolBox is essentially a sophisticated and versatile parameter/experiment browser for the Automation set-up window. Spectrometer Managers running groups of experiments will find it invaluable in helping them and their not so experienced colleagues, harness the full power of NMR quickly and easily.

The ToolBox implements a procedure called Dynamic Adaptive Automation (DAA), whereby each experiment may share relevant parameter information with other experiments. Each piece of parameter information which is shared, receives an Import/Export identifier (Name). This identifier describes some experiment characteristic which may be shared between experiments.

Experiments which are to actively adapt other experiment outcomes, must define export identifiers and define which parameter is involved. Experiments allowing for adaptation must specify which export identifiers will be imported. The overlying automation process is responsible for the timely transfer of the data between experiments.

The ToolBox browser enables the designer responsible for any experiment definition, to impart his operational knowledge of the experiment (in the DAA case an Automation Parameter Set) in such a way that inexperienced NMR users may instantly discover what process parameters may be of interest and allow for access to these parameters. Together with DAA, the process designer may thus use the ToolBox browser to define how particular experiment parameters will interact with each other.
4.2 When should I use the Toolbox?

- For **Bio-Nmr** Experiments
- When a **group of experiments** is routinely run **on one or more samples**
- When **particular parameters** are to be set identically on multiple experiments
- When **parameter modifications** are to be made on standard Parameter sets **depending on the Application**
- To link a particular Shim routine / Shim file or an ATM optimization to an experiment
- When experiment dependent default "User Specific Parameter" names and values (familiar from ICON-NMR) are required
- If **parameter values** which are set by the acquisition/processing are to be **transferred** to other experiments automatically
- If **additional/alternative application dependent** AU programs are required
- If you have previously been reusing .set files and are continually resetting the data set names
- For **Kinetic** Experiments
  See the Example Kinetic Experiment Definition accessible under
  "**File->Import->Load Example Kinetic Experiment Definition**"

4.2.1 Fundamental differences to Standard ICON-NMR Automation

Users familiar with ICON’s Automation interface that may be thinking of making use of the Toolbox’s features should note the following:

- Currently no support for strict adherence to a tight “Multiple User open access” structure is provided

4.3 Entering Toolbox Mode

Enter Toolbox mode by clicking on the respective icon of the ICON-NMR main desktop. A identification window will invite you to identify yourself. To return to the main ICON-NMR desktop click on the **Exit** button of the **File** menu.
You may also start the program directly via the *toolbox* TopSpin command.

### 4.3.1 User identification

See “User identification” on page 121 for more details on identification requirements. At the moment the user identified when entering Toolbox mode has very little influence on how the program reacts.

### 4.4 The Toolbox Window layout walk-through

This section provides a general overview of ToolBox features.

After successful user identification, project file selection (File→New Project) and Sample Addition “Add New Sample” the user interface similar to that shown in Figure 4.1 will appear on the ICON-NMR desktop.

The toolbox browser is really 2 windows in one. From here it is possible to add new experiments or groups of experiments to the toolbox, normally though, it will be used to select, modify and submit experiments to an automation run. Here are some of its main features:

#### 4.4.1 Upper Control Icons/Status Entries

- **Create New Project** creates a new project file which will contain all parameter and, where used, all automation status information. You may leave your project at any time, and return to the exact same state at a later date.

- **Add New Sample**
  Each project may contain any number of samples. A field will appear asking for the solvent definition to be set along with the corresponding holder position/sample number. At this stage, all experiment “Tree” entries are created according to the current experiment definition, for the sample.

- **Import Experiment Definitions**
  Use this to set the current experiment definition which will be used for all following new samples added to the ToolBox. A file selection dialog window will appear showing any experiment definitions which you may have previously
saved. Experiment Definitions are stored in the TOPSPINHOME/conf/instr/ICON-ToolBox/Definitions directory. When you remove experiments or add new ones you are changing the current experiment definition. The ToolBox can save the current definition for you at any time. It remembers what the current definition is, and loads it automatically (provided it has been saved) next time the program starts.

**Note**: Experiment Definitions may span single or multiple samples. So if a set of experiments is routinely used on a set of samples you may save a definition which will create multiple sample entries at the “Add New Sample” stage. Simply mark all checkboxes in the “Experiment Types” tree before Exporting the definition file.

- **Import Shared Parameters**
  
  Click here to load any import/export variable values from any other project you may have previously saved.
• **Export Experiment Definitions**

Use this to make your own experiment definition file. Mark the holder entry check box or a group of them. Experiment definitions contain the following information:

- The complete “Tree” structure of experiments and experiment groups.
- For each group, the contents of the Text window in the right hand pane. HTML style text may be displayed here if required.
- For each experiment the following information:
  1. A user definable experiment name (Independent of the Parameter Set).
  2. The name of the parameter set which will be used.
  3. A title entry window, which may also contain a default title text.
  4. Lock/Shim/ATM settings for this experiment.
  5. The Automation and Processing commands. (Normally XAUA and XAUP)
  6. A text description of the experiment. The comments from the pulse program are appended automatically after any comments added by the user.
  7. Parameters, definitions and import export variable names.

• **Submit all experiments under selection**

This button behaves just like the submit button at the base of the ToolBox. Select the Sample/Group/Experiment in the tree first to determine what should be submitted. You can use this feature to submit all experiments in the samples Tree with one click.

• **Cancel all experiments under selection**

This is a copy of the cancel button at the base of the ToolBox.

• **Show hide right pane experiment details**

Removes the right hand pane of the toolbox window. Behaves in the same manner as the Hide/Show details menu button.

• **Drag experiments into current project**

Once you have saved your own experiment definitions, you may use this feature to display them in the right hand pane of the toolbox. Then use the right mouse button to drag them from the right hand pane into your current experiment tree. Pick and choose any experiment or group of experiments from your saved experiment definition files and pack them into the current project, or make a new definition with them.
4.4 The Toolbox Window layout walk-through

- **Lock/Unlock Toolbox**
  The toolbox normally starts in a locked state. This implies that changes to the layout of the experiments and their corresponding parameters may not be made. To make any changes, click on the padlock and enter the password if required. This password check is under the ICON-NMR configuration window control. It may be deactivated if required. See the Configuration, General Options page for details. Alternatively, the toolbox may be configured to start in an unlocked state. See the ICON-NMR->Configuration->ToolBox Setup page.

- **Enable/Disable Live Data Set Generation**
  The toolbox starts up in “live” data set generation mode. This implies that when any experiment is clicked on/activated its data set will be created as part of the project in the appropriate data set directory. This happens irrespective of whether the data set will be measured or not. Where no data sets are to be generated, click on the green button which will then change to a red stop sign. In this mode, no data sets are generated and parameter values will not be updated. This mode may be used to verify/modify an experiment definition.

### 4.4.2 Experiment Selection Pane

The left portion of the window allows for the selection of an experiment/data set for measurement. Experiments are grouped together into Subgroups. Each experiment is in turn linked to a particular data set from the `TOPSPINHOME/exp/stan/nmr/par` directory. At the top of the Tree hierarchy you’ll find the sample name. This is the name which was entered after clicking on the Add New Sample button. Next to the Sample Name you’ll find a check box. By clicking on this box, you are informing the toolbox that this sample’s tree should be the default for a possible next sample which will be added. You will only need to check this box should you make changes in the current experiment definition. You’ll also find information (in the 2’nd status column) regarding the status of individual experiments (Submitted, Cancelled, Finished), plus the holder number which will be used. This information is identical to that shown in the Automation window.

New experiments or subgroups may be added to the Tree at any point. Experiments and subgroups may also be deleted at any point.
Clicking on any experiment in the tree creates its data set and sets any parameters according to the rules defined by its experiment definition. Parameter changes may be made before the experiment is submitted for measurement.

4.4.2.1 Experiment Duplication

Normally should multiple instances of the same experiment be required on a regular basis, then the experiment definition should be modified so that the correct mix of experiments is contained within the tree. However, a particular experiment may be duplicated simply by clicking on its tree entry after it has already been submitted. A message box will appear to check whether a duplicate experiment was really called for. If such a duplicate was created it creates a new additional experiment entry in the automation page, but the tree itself does not change. The already submitted entry becomes invisible and only the duplicate remains.

4.4.2.2 Experiment Selection Buttons

The following control buttons are available by clicking with the right mouse button when over an experiment in the tree:

- Add SubGroup
  Creates a new Subgroup after the currently selected location in the Toolbox Window. An entry box will appear requiring you to enter the SubGroup Name. After entering a name you may also type in a description of the sub-group in the “Group Information” window.
  You may also enter a filename in the Group Information window - in which case the file must be in simple HTML format and should reside in the ToolBox Help/English directory:
  TOPSPINHOME/prog/tcl/libtix/inmrmr/lib/BioTool/Help/English
  The ToolBox will render the HTML page in the Group Information window in the next instance of the subgroup.

- Add Experiment
  Creates a new experiment entry in the currently selected branch of the experiment tree. The currently selected branch can itself be an experiment although this is not recommended. After clicking on the button a blank experiment definition sheet will be shown in the right pane waiting for information. Fill in as much as possible before proceeding. Should you forget to define import or export parameters - this can be handled over the “Edit All” button in the right hand pane.
4.4 The Toolbox Window layout walk-through

- **Delete Group Experiment**
  Deletes the currently selected experiment / sub group entry.

- **Submit**
  Has the same effect as the Submit button in ICON-NMR Automation. The currently selected experiment will be saved on the disk awaiting measurement under automation control. If a group is selected then all experiments under that group will be submitted.

- **Cancel**
  Remove the currently selected experiment from the Automation queue. If a group is selected then all experiments under that group will be cancelled.

- **View Data**
  Saves the parameter data from the currently selected experiment according to the current import and user configureable settings. Switches TOPSPIN to this data set and makes the TOPSPIN window appear.

4.4.2.3 “Right Click” Menu

Note that all of the above buttons are accessible directly using your Mouse’s right button. When you click on your right mouse button, a popup menu window will appear. The respective action is however always carried out on the currently selected subgroup or experiment.

- **Hide/Show Details**
  The ICON-NMR ToolBox interface requires a significant amount of screen space. When the parameters have been set up correctly however, it should no longer be necessary to view parameter values continually. This button may then be used to temporarily remove the right hand (Experiment Information) pane from the ToolBox interface. This will be useful in cases where another program is being obscured by the interface. The pane may be resurrected again at any time by right clicking on Experiment Selection pane and following up with a click on the Show Details button.

- **Copy**
  Grabs a copy of the current definition for the experiment under the pointer.

- **Cut**
  Grabs a copy of the current definition for the experiment under the pointer while also deleting it from the Experiment Types Tree.
Paste
Inserts the current experiment at the current pointer location.

4.4.3 Experiment Information Pane

The right pane shows Group/Subgroup and experiment information pertaining to the selected entry in the Experiment Tree. Here are some of its features:

- Disk, DataSetName Expno

- Name, Parameter Set, Title
  The internal Toolbox name for the experiment, the corresponding TopSpin parameter set, a title line where the corresponding title may be entered. If the title is set before an experiment tree is exported as an experiment definition, then the title will be part of the experiment definition and will appear each time the tree is instantiated.

- Default Parameter Values/Commands (optional)
  A space separated list of parameters together with their values to be replaced in the copy of the standard parameter set being used. This list may also contain commands which are to be issued during creation of the data set.

  An example default list might look something like this:
  \[ \text{ns 8 td 8k CMD \{XAU my\textunderscore pulse\textunderscore determination\textunderscore au\textunderscore prog\}} \]

  This line would ensure that this special au program would be executed after ns and td were set to the 8 and 8k values.
  The exact order of events is as follows:
  RPAR-> Getprosol -> Import Variables are set -> default parameters set/commands executed (according to their order in the list)->User Configureable Parameter values determined.

  You may also pass import/export variable values at this stage and perform mathematical calculations. e.g.

  \[ \text{CMD \{XAU my\textunderscore au\textunderscore prog$O1($HOLDER)\}} \]
  would start an au program and pass the contents of the import export variable $O1($HOLDER) to it.

  CMD_ONCE is another command macro which as its name suggests will only
be executed once in the lifetime of the data set.

**Arithmetic evaluations**
Parameters may be automatically set to values which may be the result of parameter arithmetic run either when the experiment is instantiated or at experiment run time.

This is achieved by means of the CMD `{setpar "parameter name" "parameter value"}` syntax. “Parameter value” may be a mathematical TCL expression which works on experiment definition variables e.g. `[expr {$SWN($HOLDER) / 2}]` within the default parameter values commands window. Here a trivial example:

CMD `{setpar d1 [expr {100 * $D1($HOLDER)}]}`

Here the value of d1 would be automatically set to 100 times the value of the variable D1(HOLDER) before acquisition and on experiment instantiation.

Note: You need `{"}` anywhere where multiple arguments are required, as is the case in the example above.

- **Lock / Shim / ATM Settings**
  Any special case Lock/Shim/Automatic tuning and matching steps required by the experiment may be entered here.

- **Automation Acquisition Commands**
  Typically XAUA is used here and the AU program as defined by the AUNM parameter will be used. You may override this and run another au program or simply zg with the macros XAU my_acq_auprog and ZG respectively. Variable values may also be passed as shown above in the Default parameter values commands case.
  For Kinetic experiments the macro **GOTO_NEXT_SAMPLE** is available which may be used to force the automation to continue with the next available sample, even if the current sample still has submitted experiments ready to run. Here the Syntax:
  XAUA; GOTO_NEXT_SAMPLE
  is used to perform the acquisition and then continue with the next sample in the automation run.
• **Automation Processing Commands**
  Typically XAUP is used here and may be circumvented for this experiment as above. Variable values may also be passed as shown above in the Default parameter values commands case.

• **Description**
  A text window used description of the experiment together with the contents of the experiments pulse-program.

• **Experiment WWW Info**
  A HTML Link to even more experiment related information, describing procedures or parameters. This box will only be shown, if such a link has been defined. If you want to add a link later use the “Edit All” button to force the entry to appear. Remember to save a new experiment definition file based on the sample where you have made the change.

• **User Configureable, Import and Export Parameter Panes**
  Here you’ll find all the parameters pertaining to this experiment. Each group of parameters is divided into 4 columns:

  1. The internal TopSpin parameter name, e.g. ns (number of scans parameter). This is the same parameter name which you would also type in TopSpin in order to see the parameter value.

  2. A description the parameter’s role in this experiment. e.g. Number of acquisition scans. The supplied descriptions in the default experiment are supplied in English. There is nothing to stop you overwriting them in another language should that be necessary.

  3. The parameter value.
  Note that this value may only be taken as being the real value at acquisition time, provided the acquisition has been started either through Automation, via the ToolBox’s TopSpin command line or through TopSpin directly following the activation of the Popup TopSpin button. Changes in parameter values made in TopSpin will not be updated in the ToolBox window.

  4. Where defined, the name of the **import/export variable** used for sharing this parameter’s value between experiments. If you define your own import/export parameter names, you should attempt to make the names as descriptive as possible. Here you may add the variable name ($HOLDER) to the end of a variable. This indicates to the Toolbox that the variable has been pinned to the current holder setting. The current holder position will
be substituted by the toolbox when it sees the ($HOLDER) variable.

The parameters (not their values) shown here are defined in the current experiment
definition, and may be changed via the edit buttons under each pane. The current
definition file name is displayed in the box at the top of the window.

Parameter Update Timing:
The User Configureable parameters may be edited at any time and their values will
be reflected in any instance of the experiment run under Automation control. Should you click on the View Data button, the Import parameters are updated
whenever they change and will also be set accordingly in experiments run under
Automation Control. Export Parameters are updated automatically under Automation Control after the
processing AU program has completed. The status parameters are used for export-
ing purposes and the Toolbox will grab their values from the status files.

4.4.4 The “TopSpin” command line
Here you may type in any TopSpin command just as you would in TopSpin. The entry window has a history feature allowing you to recall old
commands simply by using the <Up> and <Down> arrow keys. Commands
are always carried out in the currently selected data set. Typing eda, for
example will display the Acquisition parameters for the currently selected
experiment. The parameters are always updated (from the Import List and the User Configureable List before the command is executed)

4.5 Menu Bar commands

4.5.1 The File Menu
The file menu contains the following items:
• New Project

The ToolBox always operates on a project file. This project file describes the cur-
rent state of play of the ToolBox window, including the contents of each experi-
ment window which has ever been accessed along with their corresponding
parameters. The project file is also linked to a setup file with the same root name.
You may use this menu item to open a second ToolBox window at any time. Only one window may run automation at any one time.

- **Open Project**

  Open reads in a previously saved project into the current ToolBox window. The information for the Automation window is also loaded.

- **Save Project**

  Saves the current ToolBox state of play for future re-use. Files are saved with the extension .tpf and the default directory for .tpf files is 

  XWINNMRHOME/conf/instr/ICON-Toolbox/Projects

### 4.5.1.1 Import

- **Import Shared Parameters**

  Here you may extract the shared parameters from a previously saved project file. As such it is possible to run a group of experiments based on exactly the same parameters as a previous group.

- **Import Experiment Definitions**

  Changes the current experiment definition to a previously stored one. Changes will be reflected next time the Add New Sample button is used.

- **Load Standard Bio Experiment Definitions**

  Overwrite the current default Bio experiment definition with the default one which is delivered with the program.

- **Load Example Organic Experiment Definition**

  Sets the current definition to a simple Organic one. This is by no means complete but is intended as a staging post for creating more advanced organic experiment definitions.

- **Load Example Kinetic Experiment definition**

  Here an example Kinetic Experiment definition may be loaded. For more information click on the Interleaved Kinetic Experiments Groupname in the experiment types tree.
4.5 Menu Bar commands

4.5.1.2 Export

- Export Experiment Definitions

Here you may create your own experiment definition files. The complete structure and contents of the experiment Information pane are contained within the file along with links descriptions, parameter lists and import experiment definitions and references. The actual values of the respective parameters are not contained within the definition.

In order to use this feature - you must first define which sample is to be used for the definition. With ICON-NMR 3.7 you can make an experiment definition which covers multiple samples - simply define all samples which are to be included in the definition before exporting the definition. Note that when you add a new sample with a definition spanning multiple samples, consecutive holder positions will be used for all samples.

Samples are defines by clicking on the checkbox next to the sample name in the Experiment Types tree.

Definitions are saved in

XWINNMRHOME/conf/instr/ICON-Toolbox/Projects

4.5.2 The Run Menu

For details on these menu items please see the corresponding section in the Automation manual (see The Run Menu on page 38)

4.5.3 View Menu

- Automation Window
  Displays the Automation window on start-up of the ToolBox interface

- AUNM Args / Default Parameters
  This toggles this part of the Experiment Information Window to save space in cases where it may be unnecessary.

- Parameter Names
  This removes the references to the actual data set parameters from the User Configureable Parameters, Import & Export parameter frames.

- Show Expno, Data Set and Disk information:
  Causes the data set name information pertaining to the current experiment definition to be displayed in the Experiment Information window.
- Popup TOPSPIN in Selected Data Set
  This has the same effect as the Popup TOPSPIN button at the base of the Experiment selection pane. It generates the data set where necessary or just updates the parameters to reflect the current settings.

4.6 ToolBox Usage/Adaptation

For more detailed information on the standard contents of the Toolbox’s experiment Tree widget along with further information on the experiments which make up the standard (Bio) experiment Setup - check out the HTML Help area in the ToolBox window. Detailed description is available there showing the necessary steps required to measure your first Spectra using the ToolBox.

4.6.1 Adding New HTML style Help System pages

You may add your own Help pages to complement those already included in the Bio experiment definition program. To do this there are a couple of things to keep in mind.

1. Only simple HTML structures are supported. Any HTML helpfiles you create must reside in one of the program directories of ICON-NMR. That directory is as follows:

   XWINNMRHOME/prog/tcl/libtix/iconnmr/inmrlib/lib/BioTool/Help/English

   In order for the HTML files to be registered by the HelpSystem they will also need to have the following non HTML directives in their contents

   .topic htmlfilename
   .title Title to appear in the Index Selection

   Where htmlfilename is the name of the new htmlfile excluding its extension. So if you add a new HTML file called 3dexps.htm the topic and title lines in the HTML file would appear as follows.

   .topic 3dexps
   .title My new 3d experiment page
2. As well as this the file Intro1.html (also contained within the above directory) will have to be changed to include the new file. You’ll need an extra .include directive as follows:

   .include 3dexp.htm

3. Finally you’ll have to type in the name of the html file in the experiment in the empty Group Information window to link the page with the newly created HTML file. The contents of the HTML file will be shown next time the current experiment definition is used.

   Note: This current system including the above directory may be subject to change for future versions of the ToolBox.

4.6.2 How to set the color, bold or italic attributes and 1D, 2D, 3D icons for experiment entries in the left pane

   This information is only required should you wish to improve the readability of the Experiment table by adding an icon and changing the color of an experiment entry. Presently, the ToolBox has only icons available for 1D, 2D and 3D and Watergate-experiments. To make use of these in an experiment definition the information has to be included into the experiment name.

   For example if a newly defined Proton experiment is to display the 1D icon and have the text appear in blue, proceed as follows:

   Instead of naming the experiment simply Proton it should be called

   {Proton } 1d blue

   Note the space after Proton. Should you have a name consisting of spaces this extra space is not necessary. So for example

   {My Proton Experiment} 1d blue

   would work fine. You may use the Rename command to change the names.
   The ICON and color will be shown in future instances of the definition (not in the current one).

   To make the entry us a bold font the keyword bold is necessary and should follow the blue keyword. If italic characters are also required then add the italic keyword
at the end.

Here are some more examples:

\{My Proton Experiment\} 1d blue bold italic
Here the 1d Icon will be shown and the text will appear blue, italicized and bold.

\{My Proton Experiment\} {} blue {} italic
Here no Icon will be shown and the text will appear blue, italicized but not bold.

4.6.3 Adding your own Icons

If you wish to include your own icons then create the directory:

TOPSPINHOME/conf/instr/ICON-ToolBox/Icons and copy your files into that directory. Icons may be in gif, ppm or pgm format. Icons which are added in this fashion will answer to their filename in the toolbox.

Example: Copy the file DOSY.gif to conf/instr/ICON-ToolBox/Icons

Then rename the Dosy experiment in the toolbox to:

\{Dosy Experiment\} DOSY.gif blue

The DOSY.gif will be used for the Experiment entry.
The NMR Biotools Window is a new command linked to the ICON-NMR Toolbox and accessible via the `biotools` command at the `TopSpin` command line. A brief overview of its features and format is given here.

![NMR Biotools](image)

**Figure 4.2 NMR Biotools**

The Biotools interface is designed to guide you as effortlessly as possible to an intelligent set of experiments, designed to match your spectroscopic “line of inquiry”. The program generates a “project” file as mentioned in this chapter, where all information pertaining to the experiments are kept. However, in contrast to the Toolbox only a minimum of information is presented to the user and no changes in the manner in which the Biotools module operates are accessible to the end-user.
The Quick Screen Page provides at a glance access to some of the most powerful experimental tools available for giving an overview of the sample in as short a time as possible. These experiments may be run before the long term 3D experiments are employed. Note: Default Parameter Values may be modified to suit the current project or for all.

Project files with all pertaining information, including the project Automation run and current state of play regarding completed experiments etc., are available on disk and may be called up instantly to add further experiments to those already completed.

Check the online documentation for updates to this NMR Biotools manual.
4.7 NMR Biotools

4.7.1 Modification of the Standard Biotools Interface

NMR Biotools, being embedded into TopSpin’s Automation software benefits from all the development and fine-tuning which has been invested in the automation productivity software. And as it is a part of the ICON-NMR Toolbox, configuration to suit any laboratory environment is simply a matter of adjusting the default experiment definition files delivered with the program.

These represent the templates the program uses to know which experiments and parameters are of interest, which parameters must be shared between data sets and

![Default Setup Parameters](image)

**Figure 4.4 Default Setup Parameters**
whether changes have been made to any of the standard parameter sets.

These files may be found in:

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/lib/Biotool/Defaults.

To make modifications to the standard Biotools package, start Biotools and click on the Expert mode button. Then import the correct .edf file from the above directory corresponding to the group which you wish to change. Make any changes in the toolbox interface and export the newly adapted definitions to the same name and directory. Next time the Biotools software is run the changes will come into effect.
Chapter 5
Configuration Suite

5.1 Overview

The Configuration Suite (Figure 5.1) is started from the respective icon in the main mode of ICON-NMR. You may also use the Configuration Suite menu in Routine Spectroscopy, Toolbox or Automation modes. This window may only be activated if you know the NMR Super User password or if password checking has been disabled.

Configuration Options

The configuration suite is used to configure all aspects of ICON-NMR. At the moment the Configuration Manager is divided into 18 pages: User Manager, Additional ICON-NMR Users, Originator Items, Composite Experiments, Automation Window, Master Switches, Lock/Shim Options, Solvent/Probe Dependencies, Automatic Tuning/Matching, Priority, Temperature Handling, LC-NMR Options, SampleTrack Options, Fail Safe/Error Handling, Web Interface, General Options, Toolbox Setup and the Accounting program

Saving>Loading Multiple Configuration Settings

Although there are very many different configuration settings within ICON-NMR, it’s easy to create slightly different Configuration setups for different Autosampler
hardware or Automation scenarios. You may save all settings which govern how Icon will operate internally into a single Configuration File. These may be loaded back whenever necessary and will set multiple Configuration settings on multiple Configuration window “Pages” in one swoop. Use the Load and Save menu entries to save and reload multiple configuration settings. Note that User specific and other Instrument settings (e.g. Composite Experiments) which are not expected to change are not saved in such .icf files.

Update Run Parameters

Some configuration settings will not take immediate effect, and this is especially true for an automation run which is already in progress. Use the menu entry Update Run Parameters to force the run to reset its internal configuration settings according to the new settings. For some configuration settings such as the Sample-Jet driver setting, a new Automation window with the correct sample position format appears.
5.2 User Settings

5.2.1 User Manager

The User Manager lets you comfortably control just how much freedom the users of the instrument are going to get. These features apply for the most part to both the Automation and Routine Spectroscopy parts of the program. Setup one template for your users and save it for all the users on the system. Update the experiments which have been cleared for particular users in one sweep. Save user specific information which can later be used to group particular users with similar information together. Custom tailor (for your lab) exactly what information the user must enter before any experiment may be started (E.g. An Originator ID describing the probe being measured.)

Now you can restrict the input to suit your particular file handling needs.

5.2.1.1 The User Names box

When first started the User Manager shows all the workstation user names and Additional user names which are currently defined for ICON-NMR in the User Names box (Figure 5.1, upper left). Additional users do not normally need to be defined. Those users who already have a userfile are shown with a bold font and have an “enabled” indicator icon. You can add so called “Additional Users” (who do not have login permissions on the workstation) by using the “The Additional Users page” on page 94.

5.2.1.2 Adding a new user

All items displayed in the various boxes of the User Manager window are valid for the user whose ID is highlighted in the User Names box. Click on the name whose user information you wish to view or change. The respective information is then loaded from a file and displayed. When you're happy with the settings for a particular user, save the file using the save button. After this ‘save’ action the user will have a login account for Automation, the ToolBox and the Routine spectroscopy programs.
5.2.1.3 The Experiment List box

This listbox is used to define the experiments a user may perform. The list shows all experiments currently enabled for the user selected in the User Names box. The mode and details of the experiment are shown. Mode defines whether the experiment may be run anytime (sun) or only at night (moon). Details comprises three columns show experiment type, name and comment.

The type is encoded into a single character: N denotes a normal (single) experiment and C a composite experiment. A composite experiment is a sequence of normal experiments which can be defined in the Composite Experiment Manager. The member experiments of a sequence may depend on each other. For example, the first experiment of a sequence could be a preparation experiment for a subsequent 2D experiment. In such cases, the composite experiment manager allows you to specify the reference experiment(s).

5.2.1.4 Setting up the experiment list

To make any changes in this list you must first activate it by clicking on an entry in it or by using standard keyboard traversal (tab key) to activate a particular entry.

The entry box shown in the center of Figure 5.1 will show the type of experiment you have selected in the list, its name and its comment. Use the following buttons to alter the list:

- **Update User Files**
  The contents of the respective listbox (Experiment List, Partition Names, etc.) may be saved to several user files, leaving all other information in the respective user files intact. Choose the user files you wish to update from the list shown in Figure 5.2.

- **Delete**
  Remove the marked (=highlighted) experiment(s) from the list. In order to remove several experiments at once, mark them in the following way: Click on one of the experiments using the left mouse button. Keep the button depressed and move on to the next line, and so on, until all desired experiments are marked. You can achieve the same effect by marking the first experiment with a
mouse click followed by a mouse click on the last experiment while the Shift key is held down. If you want to delete several experiments which are not displayed on subsequent lines, hold down the Ctrl key while you click on the relevant experiments.

- **Prepend**
  Use this button to add a new experiment above the currently selected experiment. Select the name of the new experiment from the button at the right of the *Experiment Name* entry. The displayed list is constructed from the parameter sets present in the directory `TOPSPINHOME/exp/stan/nmr/par/`, and the defined composite experiments. This means that you can only add an experiment to a user’s experiment list if the respective set of acquisition, processing, and plotting parameters already exists. If you did not set up your own experiments, Bruker’s standard experiments and standard composite experiments are available, provided TopSpin’s `expinstall` command was run successfully.

  Before you add the experiment to the user’s list, you may change the comment. The experiment type is a view-only parameter which can take on the values *Single (Normal) (N)* or *Composite (C)*. When you add a new parameter set to the directory `TOPSPINHOME/exp/stan/nmr/par/`, it will be assigned type N by default. If the new parameter set designates an experiment requiring preparation experiments, you must define a composite experiment in *Composite Experiment Setup* mode, which includes the preparation experiments. You can give the composite experiment the same name as the parameter set: If a composite experiment and a parameter set use the same name, the name will only appear
once in the user’s experiment list, and the executed experiment will be the composite experiment.

- **Append**
  As the name suggests this button adds the information to the list after the currently highlighted entry. Apart from that, everything said about *Prepend entry* is valid.

- **Modify**
  This button allows the information shown in the entry field to be transferred directly to the currently highlighted line in the listbox.

- **EXIT**
  This button removes the entry box from the top of the window. The entry box disappears.

You can now change the order in which the experiments will appear in the user specific experiment list by using the right-mouse button to move experiment entries around in the list. First set the focus to the Experiment List (by using the tab key), that way you can then grab an entry from the bottom of the list, use the Pg Up key to move the listbox to the top and then release the mouse button to drop the entry. You do not have to set the focus first if you only wish to move an entry around in the currently visible part of the list.

### 5.2.1.5 The User Permissions panel

This panel is located below the User Names box of Figure 5.1 and allows you to enable or disable certain ICON-NMR features for a user.

**Priority**

A user may declare a sample or experiment to have a priority status. This option is only meaningful for automation with a “random access” sample changer. The Six-Pack and NmrCase changers may only operate in a sequential manner and Priority will be disabled automatically if such sample changers are in use.

Use the Configuration window in the system manager to define how the priority switch is to be handled.

**Archive Data**

Use this option to copy all the current experiments data to the *Archiving Directory* (also entered from the user manager) after processing has been completed on the
current experiment. This uses the TopSpin *wrpa* command. Problems are reported in the Remarks section of ICON-NMR’s history table.

**Supervisor**
If enabled for a user, the next time this user starts ICON-NMR all ICON-NMR windows will get borders and a menu bar, allowing them to be moved or iconified on the desktop, thus allowing access to other programs without having to terminate ICON-NMR. This permission will also gives such users full control over TopSpin to start/stop other processes at will.

**Essential Originator**
If enabled, the user must fill in the originator entry which appears in the filename entry box before he can carry on with the setup.

**Manual Lock/Shim**
If enabled, the user has permission to override automatic locking and shimming via the menubutton “Manual Lock/Shim”. He then will be able to lock shim manually. If disabled, the automatic procedures will be enforced for this user.

**Parameter Edit**
If enabled, the user may invoke the parameter editing commands from the Parameter menu in Routine Spectroscopy or Automation modes and alter the acquisition, processing, or plotting parameters of an experiment before he starts it.

**Exit (Icon-Nmr)**
If enabled, the user may terminate ICON-NMR.

**Data Set Edit**
If enabled, the user may define his own data set filenames. If disabled, he may only choose from the names provided in the Sample Names box (see below).

**Originator**
If enabled, the so-called originator information and the associated user specific information will be included in the filename setup box for Routine Spectroscopy or in the title window for Automation modes. You set up originator information from the Managers->Originator Setup menu, and user specific information from the respective box in the User Manager window. See “The Originator Items Editor” on page 95.

**Mail Spectrum PS/PDF**
ICON-NMR has a general plot file PS/PDF mailing system available. It may be
enabled under Configuration->Master Switches->Generate Spectrum Print out for possible e-mail to recipient. This flag enables this feature to be user specific. If enabled, the user will receive an email containing a Post Script or PDF file containing the spectrum after acquisition and processing, provided a valid email address for the user is available. See the note on Data Mail below regarding the SMTP configuration.

Email Notification
If enabled, the operator will receive an email notifying him of the completion of his/her experiment provided:

a) Email is operational on the controlling workstation. (A valid smtp mailserver has been entered on the general options page)

b) The Target Email Address (also available in the User Manager or as an Originator Item) has been setup correctly for the current user.

Data Mail
For this option please enter a suitable SMTP mailserver name on the General Options configuration page. If this is not available or unknown then ICON will attempt to use the smail script and the default mailing program to send the mail. On Linux this is the mutt program which is available on the Linux Installation CD’s.
This option sends both 1D and 2D data on the Internet to the Target Email Address (if defined).

Edit Lock/Shim/ATM (Automation Mode Only)
Use this permission flag to decide whether the User should be allowed to change the default lock/shim/atm settings. When this flag is activated the user will have an additional menu button, (with a lock signal displayed on it) in the Par column of the setup window. If multiple experiments have been submitted for a particular holder position, some of this information may be ignored. For example, if the Shim setting is to be considered for each individual experiment then the configuration option “Shim the sample” in the Shimming Controls window should be set to “on every experiment”

JDX Copy
From ICON-NMR 3.1 onwards it’s possible to have ICON-NMR generate a copy of the data set in JCAMP-DX format and store the data with an unique name in a directory as specified by the fields shown under the General Options Tab of ICON-NMR’s Configuration Suite. This feature is in addition to all the other Archiving/
5.2 User Settings

Data Mail modes.

**ZIP Copy**
Works in exactly the same way as the JDX Copy mode described above.

**ZIP Data Mail**
Work as the Data Mail option, except that the attachment is in the zip format.

---

### 5.2.1.6 The Sample Names box

Use this box to define the data set NAMEs you want to propose or prescribe for a particular spectrometer user. All names defined here will appear in the names list of the Filename box where the user defines the data set name during experiment set up. If you enable the Data Set Edit checkbutton (see above), the user may also enter his own data set name. Otherwise he will be restricted to those you set up here.

ICON-NMR provides five special names, $DATE, $DATEUSER, $NUMERICDATE, $USER and $HOLDER. These macros will be expanded when the user opens the names list in Routine Spectroscopy and Automation modes. You can also make use of date variables such as %M and %Y etc. to form your own standard data set names. For your convenience these variables are listed here:

%%
Insert a %.

%a
Abbreviated weekday name (Mon, Tue, etc.).

%A
Full weekday name (Monday, Tuesday, etc.).

%b
Abbreviated month name (Jan, Feb, etc.).
%B
Full month name.

%c
Locale specific date and time.

%d
Day of month (01 - 31).

%H
Hour in 24-hour format (00 - 23).

%I
Hour in 12-hour format (00 - 12).

%J
Day of year (001 - 366).

%m
Month number (01 - 12).

%M
Minute (00 - 59).
5.2 User Settings

%p
AM/PM indicator.

%S
Seconds (00 - 59).

%U
Week of year (00 - 52), Sunday is the first day of the week.

%w
Weekday number (Sunday = 0).

%W
Week of year (00 - 52), Monday is the first day of the week.

%x
Locale specific date format.

%X
Locale specific time format.

%y
Year without century (00 - 99).
%Y
Year with century (e.g. 1990)

%Z
Time zone name.
In addition, the following field descriptors may be supported on some systems (e.g. Unix but not Windows):

%D
Date as %m/%d/%y.

%e
Day of month (1 - 31), no leading zeros.

%h
Abbreviated month name.

%n
Insert a newline.

%t
Insert a tab.

Click in the Sample Names box to open the respective edit box at the upper right corner of the User Manager window. Enter the desired name, $DATE, $NUMER-
ICDATE or $DATEUSER and click on Prepend entry or Append entry to add the name to the list. Click on Delete entry to remove the currently selected name from the list. Click on Modify entry to apply changes to the currently selected name. Update users may be used to save the listbox settings to multiple user files.

5.2.1.7 The Spectrum Number Filename entry

This entry at the bottom of Figure 5.1 provides an additional method of prescribing data filenames.

The contents of this entry field will be considered as the pathname of a text file (Example: /usr/adm/spectrumno.txt) set up by the laboratory manager. The file must hold a name beginning with letters and ending with a number, e.g. H1000 or C1. This name will appear in the names list of the Filename box where the user defines the data set name during experiment set up. This particular type of data set name will automatically be incremented with the next sample. The names in the above example would then change to H1001 and C2. The incremented name will be written back to the text file: Should ICON-NMR be terminated and restarted, the user would still get the next name in sequence for his new experiment, provided he uses the Eject & Terminate option in the insert sample window.

For Automation, when this file has been defined, only the name prescribed in the file will be available to the user.

5.2.1.8 Target E-mail Address, Archiving Directory and Umask

These three entries allow the above items to be defined on a per user basis, even for so-called NMR users who do not have a direct login on the workstation. The archiving directory could be used for example, to define an NFS mounted filesystem which is to be used to store a copy of any experiments data after processing. The workstation manager is responsible for the setup of such an archiving directory.

In TOPSPIN 2.0 all data sets generated by the programs have audit trail files which catalog what has been done on the data set. See the TOPSPIN release letter for more information. When ICON copies the data set to a new location - the path contained within the audit trail file is corrected and the tag “ICON-NMR Copied from” included in the history information. Also the id of the user who actually submitted the experiment in ICON-NMR is also
Beginning from ICON-NMR 3.1 the archive function never overwrites data set directories which already exist on the target drive. If the Data Set directory with the particular expno already exists, ICON-NMR will add a prefix _<Number> to the Data Set Name and try to do the copy again. It will keep incrementing the <Number> prefix until a free directory is found.

The Umask entry stems from the Unix world and has some influence over the data permissions on Windows workstations. In that case, the order of the rw (read, write flags in as follows. (rw-rw-rw-). The first rw refers to the currently logged in User, the second refers to the group NmrUser, and the last refer to “Everyone”. It should be noted that the ownership of the data cannot be “given” to another Windows user. Ownership on Windows® systems can only ever be taken.

5.2.1.9 The Data Directories box

Use this box to define the disk directories where data sets acquired by the current user may be stored (this corresponds to the possible settings of the TOPSPIN parameter DU). If you allow for several directories, all names defined here will appear in the Filename box where the user defines the data set name during experiment set up.

Click in the Data Directories box to open the respective edit box at the upper left corner of the User Manager window. Enter the desired directory and click on Prepend entry or Append entry to add the partition to the list. Click on Delete entry to remove the currently selected partition from the list. Click on Modify entry to apply changes to the currently selected partition. Update users may be used to save the listbox settings to multiple user files.

In Automation mode the parameters are accessed from the Par column button which is displayed on every active experiment entry line. The Commands may be accessed from the Parameters pulldown at the top of the setup window.

5.2.1.10 The User Specific Information box

Using “The Originator Items Editor” on page 95, you set up entry items which will appear in the Filename box (when using Routine Spectroscopy), or in the Title window (when using Automation) where the user enters the data set name for an experiment. The corresponding entry fields (e.g. Department, Costing Group, or whatever you have defined) will remain empty, and the user must enter a suitable item, e.g. a department number. In some cases the item to be filled in is known in
advance, and the user should not need to type it in (e.g. his e-mail address).

Click in the User Specific Information box to open the respective edit box at the upper right corner of the User Manager window. Select the desired item (which you have previously defined via the Originator Item Editor) from the User Information Type pull down menu of this box (e.g. the item Mail Data/Notify to). Enter the respective user data (e.g. the user’s e-mail address) into the User Information Data entry. If the data changes from experiment to experiment then you should leave the Originator data field empty. The user can fill it in at experiment set-up time.

Click on Prepend entry or Append entry to add the information to the list. Click on Delete entry to remove the currently selected information from the list. Click on Modify entry to apply changes to the currently selected information. Update users may be used to save the listbox settings to multiple user files.

**Tip - Grouping Users for Accounting Purposes:**
Note that you may use this information to group users together for accounting purposes. The Accounting program may search for particular values of originator entries. If all users belonging to a particular group have the same default originator item entry, then you may find all experiments performed by such members from the ICON-NMR Accounting program. At the Originator field in the Accounting program select the correct originator entry and enter the value to search for.

### 5.2.1.11 User Specific Parameters/Commands

Here the laboratory manager may define the names of parameters or commands which the specified user is allowed to change or run. The Parameter Edit permission does not have to be enabled to allow this type of parameter editing.

As an example, if the user should only be allowed to alter the TD parameter then the Parameter Edit checkbutton should be de-activated and the entry td added to the user specific parameters/commands list.

Note that TopSpin commands may also be entered in this box allowing users with no “Supervisor” permission to access specific TopSpin commands. In Automation, where possible the command will be run on the appropriate corresponding acquired data set.

You may configure entries from this list in the same manner as described above for the Partition Names box.
5.2.1.12 The **Delete, Default, and Save buttons**

The respective commands are also accessible via the *File* menu. The Save button saves the current settings on disk, in the file 

```
TOPSPINHOME/conf/instr/<instrument-name>/inmrusers/<userid>
```

The *Default* button initializes all boxes with the default information stored in the file 

```
TOPSPINHOME/exp/stan/nmr/lists/sam_users_exam.inmr
```

You may save everything you have set up so far for several users at once. Hold down the CTRL key and mark all desired users in the *User Names* box by clicking on them. Or keep the Shift key depressed while clicking on a user. This will automatically mark all users from the currently selected one to this position. Then click on the *Save* button.

Use the Delete button to remove users from ICON-NMR. Mark the users you wish to delete and click on the delete button. Their user file will be deleted.

**Tip:** You may also re-run the processing in ICON-NMR Automation by submitting the experiments to be re-run and starting the Automation using the “Processing Only” Automation driver.

5.2.2 The **Additional Users page**

Additional Users are Spectrometer Users who do not have a Unix user account on the workstation managing the spectrometer. They may, however, still perform experiments and the experiment information fids etc. will be stored using the NMR effective users ID and permission as defined. Additional Users is an extra feature available only in ICON-NMR. These users need not be defined for normal operation.

All Additional Users may have their own password and may initialize or reset it once they have logged into ICON-NMR.

Additional User names and the respective abbreviations used for their names are shown in the listbox above the command box. You may modify this list using the Delete, Append, and Modify buttons shown next to it. The Append entry button acts relative to the highlighted position.
5.2 User Settings

The NMR Super User is the name of the privileged user whose password (provided one exists), must be entered before carrying out potentially sensitive tasks. This information is defined when TOPSPIN is installed. It should normally not be necessary to change this. Should you wish to change the NMR Super User then please use the installnmr script in TOPSPINHOME/prog/bin.

Each Additional User name entered here also appears in the main User Manager Window User Names list box. User specific information may the be set up there.

5.2.3 The Originator Items Editor

Originator Items are user defined fields which are added to the experiment title. These Items may be user specific, may contain multiple optional values may be configured to obey certain rules and users may even be forced to enter some text in them before an experiment may be accepted.

The Originator Items Configuration Window pane lets you edit the list of items which may be entered, when an experiment is being setup. Each entry in the list box created here will appear along with an entry box where the corresponding information is to be entered (provided the Originator checkbutton for the particular user has been activated).

Click on the ‘Add new’ button to add an entry. A combo box will appear where the name of the Originator Item may be entered. Entries may be swapped or re-ordered by clicking on one and moving the entry with the mouse up or down.

If a “Regular Expression” is set for the Originator Item then the value of the text entered in Automation will be tested for conformity to the defined expression. Here a simple example which may help to start you off.

\[A-Z\]{2,4}[0-9]\{4.5\}

Here only text commencing with between 2 and 4 upper case characters in the range A-Z and which is followed by between 4 and 5 characters of a numeric type will be accepted. Any other text outside of these limitations will be rejected at submit time.

Use the User Manager window to decide on a per user basis whether the additional entry boxes will appear at all (Originator Checkbutton) and whether the information must be entered before the experiment may be submitted and started (Essen-
tial Originator). Default values on a per user basis may be entered in the user specific information box in the User Manager.

5.2.3.1 Automation Mode Options

ICON-NMR has options to control originator handling more flexibly.

- Generate orig file in Data Set
  Control whether an “orig” file containing the originator information, will be saved in the data set.

- Include Originator Item field in orig/title file
  Determines whether the Item Names will appear in the title file or Orig file. “

- Insert this text between Originator Items
  Used to control exactly how the originator information will be formatted. Here you can separate the items by a newline \n, a tab \t or simply a space.

- Display/Document only those originator items defined for the user
  From ICON-NMR 3.7 / TOPSPIN 1.2 onwards, not all originator items need be displayed. If this switch is activated, then only the Originator items defined for the current user will be shown. This is especially useful in connection with the Essential Originator flag as not all users may be required to set all Originator items.

ICON-NMR provides a special Originator Item called “Mail Data/Notify to”. This entry may be used in the Automation mode to override the E-mail address for the current user as set up in the user manager. This is useful for installations with a large number of users where only one user configuration is being used.

If an E-mail address is entered here then it will override the User Manager E-mail address setting for the user. If there is no E-mail address for the current user and no address has been entered in Automation mode at the respective Title entry field, then no E-mail will be sent. This way you can decide on a per experiment basis when a notification/data e-mail will be sent. Note that the E-mail Notification and Data Mail notification flags for the particular user determine what type of e-mail will be sent (if any)
• Standard Originator Values

Consider the case where a single user account in ICON-NMR is being used for all measurements even though multiple operators are using the instrument. In this case you may want the name of the Operator to appear on the plot and be stored in the data set. Defining an originator Item called ‘Operator’ would allow for each operator to set their name in the corresponding originator field. This would however prove cumbersome as each user would have to type in their name every time before submission. They may even make mistakes in typing, making it difficult to find the data at a later date.

With the ‘Standard Originator Values’ setting, a group of possible values may be set for each originator item. The list may be read-only or may be set to pick up and remember new values as ICON-NMR Automation progresses. The list may be loaded from a simple text file (one entry per line) via the ‘Load list’ button, or may be added/edited in this window manually. Use the ‘Refresh list’ button to grab any changes which may have come in from the current Automation setup.

The entries in the list are shown alphabetically. The last recorded settings are stored in the file

```
TOPSPINHOME/conf/instr/<instrument-name>/inmrusersl.orig_values
```

If you wish to discard any changes made to the values, close and re-open the configuration window without saving. These values are also available via the standard Web Icon interface.

Note:

ICON-NMR Versions before ICON-NMR 4.1 used a special file .mailaddr to record any email addresses which were set via the special ‘Mail Data/Notify to’ Originator Item. These values will be imported automatically into the ‘Standard Originator Value’ system when ICON-NMR 4.1 is first started.

### 5.3 Composite Experiments

Experiments that may be executed by a user from ICON-NMR are stored in form of parameter sets (i.e. acquisition, processing, and plot parameter files) in the directory

```
TOPSPINHOME/exp/stan/nmr/par/
```
Bruker experiments are installed in this directory by the `expinstall` command in TopSpin. The laboratory manager may add new parameter sets. An experiment name is the name of a parameter set directory, e.g. the COSY experiment would fetch the required parameters from the parameter files from the directory `TOPSPINHOME/exp/stan/nmr/par/COSY/`.

A composite experiment is a sequence of several such experiments. In the composite experiment manager you define new composite experiments or alter existing ones. You assign a name to a new composite experiment, and you specify the names of the experiments that should be included, and the sequence of their execution. When a spectrometer user selects a composite experiment, all components are executed automatically. Composite experiments may not include other composite experiments.

In ICON-NMR, any experiment requiring preparation experiments must be set up as a composite experiment. For example, a sweep width optimized Cosy would be defined as a composite experiment consisting of a suitable 1D, followed by the actual 2D experiment. A preparation experiment is designated reference experiment within ICON-NMR.

5.3.1 Defining experiments

In order to define a new or alter an existing composite experiment, click on the “Add new” button at the base of the manager window.

Apply your changes in the Composite Experiment Editor window shown in Figure 5.3 or enter a new name and a comment. Click on the Modify button to make the modification effective, or click on Prepend or Append to add the new experiment to the list.

Click on the Experiment Name button and select the first experiment of the composite experiment and append it using the Append button. Carry on in this way adding other experiments to the composite experiments. If an experiment you want to append requires one or two reference experiments, use the F2 Reference and F1 Reference buttons to select them. When you click on these buttons, all experiments which are already part of the composite experiments will be displayed along with their sequence label (a, b, c, ...), and you can choose which ones should serve as references.
5.3 Composite Experiments

5.3.2 The ‘Save to’ button

After a new composite experiment has been defined you may wish to ‘save’ it to a particular users user file, thus bypassing the User Manager page.

Mark the composite experiment(s) you wish to save and click on the ‘Save to’ button. A list of the users who currently have a user file is shown. Mark the particular users who are to use the newly defined composite experiment and use the ‘Save to selected users’ button.

The marked composite experiment(s) will be appended to the start of the respective users experiment list.

5.3.3 The Default, Revert and Save buttons

The Save button saves the current settings on disk, in the file:

`TOPSPINHOME/conf/instr/<instrument-name>/inmrusers.pool_txt`

The Default button initializes all boxes with the default information stored in the file:

`TOPSPINHOME/exp/stan/nmr/lists/def_comp_exps.inmr`

The Revert button reloads the last saved settings from the `inmrusers.pool_txt` file.
5.4 Automation Window

5.4.1 Display

- Holder Status Display Style
  Here you’ll find two different status ‘traffic light’ styles, North American and European, plus a spell-it out text only mode. There is also a Bruker Standard Style which uses the same color-coding as Bruker’s SampleTrack interface.

- Default Number of Sample Holders
  The number of samples to be shown in the experiment manager window can be set here.

- Approx. overhead time for sample change (secs)
  ICON-NMR calculates the time required for the acquisition in order to know how long the instrument will be busy. With this window you can define just how much time ICON should allow for the sample changing/locking shimming/automatic tuning and matching etc. when calculating the total busy time.

- Experiment acquisition time calculation
  Every time an experiment is submitted the experiment time as calculated by the TOPSPIN expt command will be shown. This calculation is done once per experiment type and in cases where the parameters have been changed.

- Touch Screen/Large Icons Mode
  This check button puts the ICON-NMR Routine Spectroscopy and Automation modes programs into Touch Screen mode. All ComboBox style input widgets switch to a large icon mode which may be easily be accessed on touch screens. Title/Parameter Input windows get a “virtual keyboard/keypad” eliminating the need for Keyboard and mouse.

- Show Disk Column for Viewing editing
  Here the Disk column may be removed or disabled from the Automation window.

- Form Style Entry Mode (Preliminary)
  Here the sample position, data set name and experiment number is managed automatically (using either the Spectrum Number Filename or User Manager Data Set Name entry). All that remains is for the user to set Solvent and Exper-
5.4 Automation Window

iment and Title/Originator Info. Restart the Automation window for the new fields to appear.
Comments on this new system please to nmr-software-support@bruker.de.

- Allow Search of Preceding Experiments
  Disable this checkbutton so that users may not search through Icon’s records of previous experiments.

- Enable Tools Window
  Disable this checkbutton to prohibit use of the “Send to Icon” and “Run periodic experiment” features in the Tools menu.

5.4.2 Controls

- Spectral Viewer
  ICON-NMR can use the Amix-Viewer program to view completed spectra. Double Clicking on an entry in the history portion of the Automation Window will cause the configured viewer to appear displaying the particular spectrum. Subsequent double clicks will replace the spectrum with the new one. With the Amix-Viewer it is possible to load several spectra into the same viewer for comparison purposes.

- Logout Idle users Automatically
  In an open access environment, operators should be required to log themselves out after they have submitted all their experiments to be run. They may, with this option be logged-out automatically after a certain amount of ‘Idle time’ has elapsed. After this period of inactivity the Identify User window will re-appear and the experiment manager window will be disabled. It is, however, still possible to observe what the Instrument is doing. Use the Logout Delay to adjust the required idle time.

- Enable Automation Controls Window
  This flag determines whether a control panel similar to that shown in Figure 6.5 on page 132 will be shown during an automation run. This feature may be disabled to prevent users from (for example) processing the data.

- External Setup Directory
  Normally external setup files are picked up in the TOPSPINHOME/prog/tmp directory. The default setting may be set to another directory via this entry. This is especially useful if a “pool” directory is to be used where multiple ICON pro-
grams scan the same directory looking for an external setup file based on say a BEST-NMR well plate barcode.

5.4.3 Default Solvents and Experiments

- Default Solvents and Experiment
  To set the solvent and experiment fields automatically (in cases where they are rarely changed), enter the settings you require here. Use the blank entries if ICON should not set the solvent and experiment.

5.4.4 HTML Export Files

- HTML History File
  ICON-NMR can save all the information stored in the history list in HTML format. This entry is used to define where ICON saves this file. It’s a good idea to make sure that everyone can write to this file. If this file is located in a directory which is supported by a HTML server the History may then be observed remotely, over the net.

  Note the history file is always stored in a plain text format with a .hist extension with the same name as the setup directory itself i.e. in TOPSPINHOME/prog/curdir/changer/inmrchanger/<setup directory name>.hist

- HTML Setup File
  Here you can define the location of an HTML file which will display the current status of the Automation Setup Window in an HTML format.

  If the paths for both setup and history information are identical, then all information will appear in that single file. These settings are now superseded by the Icon-Web interface. See “WEB Interface” on page 49.

5.5 Automation Driver Engine

5.5.1 Master Switches

These options apply to the Automation part of ICON-NMR only. The “Driver” is responsible for all spectrometer control commands which ICON-NMR issues to perform experiments. As such it is ICON’s engine.
5.5 Automation Driver Engine

For more information on drivers see 'Drivers’ on page 35.

5.5.1.1 Run Control

- Default Automation Mode
  This is the standard mode of Automation which the program shows when the run is to be started. For more information on drivers see 'Drivers’ on page 35.

For SampleJet an additional frame appears showing the default sequence of samples the sample changer will follow when working with racks. The order of sample positions in the setup window will follow the order defined here.

- Eject Last Sample in queue
  When this check button has been activated the sample changer will also eject the last sample which has been measured, after all other submitted samples have been measured. Some automation modes do this regardless of the setting e.g. MAS, HRMAS.

- Never Rotate the Sample
  This may be interesting for some users who wish to disable sample rotation completely without having to edit the acquisition parameters (RO) of all parameter sets used in Automation.

- Start run at User Login
  Normally the run must be started manually after starting the Automation part of ICON-NMR. This means that operators who forget to do this, will submit their experiments for execution and leave the instrument, to do the work which it will never see. To get around this potential problem the Run may be started using this function automatically. When this mode has been activated you must also define which driver is to be started automatically. Use the Default Automation Mode to define this.

5.5.1.2 Processing Control

- Generate a Spectrum Printout
  Use this feature to suppress the printing normally associated with the execution of the processing AU program. Processing will proceed as normal but no paper printout will be generated.

- Process Data Sets after Acquisition
  Possible settings include ‘Always’, ‘Never’ or ‘Ask on Start-up’. When using
Ask on Start-up a checkbutton will be displayed in the window which appears after clicking on the ‘Go’ button.

- Generate Spectrum print-out file in data set for possible dispatch to e-mail recipient
  When this option has been activated the processing program will be started with an additional argument (-e). In this case a postscript or pdf file containing the contents of the plot will be created in the pdata procno directory. When ICON then sees this file it will pick it up and send it to the currently defined E-mail address for the user who executed the run. After the postscript file has been successfully sent the file will be deleted.

**Note:** If no E-mail address is available the postscript/pdf file will not be deleted.

This setting is also dependent on the User Manager->Mail Spectrum PDF/PS permission being activated

- Perform Structure Consistency Check
  When this flag is activated, an additional column will appear in the Automation window where a MOL/SD file may be defined. A Combo box will show any molfiles present in the STRUCTURE_DIRS list of directories as set in the TSHOME/conf/parfile-dirs.prop file.

When a MOL/SD file is selected, a special AU program vyhsqc (Verify HSQC) will be run before and after acquisition to enhance the plot software output to include structure verification information and hence check the degree of conformity between the MOL/SD File and the attained spectrum.

Fields for MOL/SD entry will also appear in the standard web interface and also in the Import SpreadSheet dialog.

### 5.5.1.3 Data Set Management

- Ignore the TopSpin Prosol Parameters
  This is a useful feature which tells ICON-NMR not to update the parameters which are usually controlled over the edprosol interface. That way you can be certain, if you save your parameter set with “wpar ParameterSetName all”, that you will always be able to reproduce the experiments under exactly the same conditions.
5.5 Automation Driver Engine

- Delete temporary Data Sets after experiment end
  With this option activated some disk space will be saved during the run. However, if you wish to retain modified parameter information in it is better to leave this option off. Otherwise modified parameters may be lost should you wish to resubmit a completed experiment.

  Temporary data sets will be removed by ICON on exiting if you do not save the setup. Icon uses the temporary data sets to store changed parameters, save time when using the Copy function and for other reasons. The data sets are stored in TOPSPINHOME/prog/curdir/changer/inmchanger/MonthDay-Year-Time-user

  The date information is obtained from the system when the setup window is first opened.

- Allow Overwrite of existing Acquisition Data
  This prevents ICON-NMR from overwriting the nmr data. The check is made at experiment run time. The program looks for an fid or ser file in the corresponding data directory. Should acquisition data be present at run time the experiment will be skipped and the remarks column in the history window will indicate that the data already exist.

5.5.1.4 Best Mode Settings

Here you may switch ICON into BEST (Bruker Efficient Sample Transfer) mode. Leave this option off unless you have purchased BEST! BEST uses a flow injection technique to boost sample throughput to the limit. In BEST mode there are various configuration options possible via the bestadm commands. These are accessible from the BEST Administration Tool button.

- BEST-NMR Automation Mode

Various modes are currently supported:

  • Standard (No Barcodes)
    Use this for handling BEST-NMR without a Barcode reader. It provides for external setup file support. In this case the HOLDER keyword should be set to the same text that appears in the setup window in the holder column.
• **Barcode/Sample Track Support**
  This should be used if a barcode reader is present and the Sample Track™ Interface is employed.

• **Barcode/External Setup Support**
  Use this if you wish to use external setup in conjunction with a barcode reader. The software will search for the appropriate external setup file after the barcode is read. One file is expected per rack/well plate (barcode label). Filenames must match the scanned barcode ID exactly. The relative positioning of the well plate/rack on the Gilson bed is taken into account via the HOLDER keyword. Barcode Labels must be in the required Bruker Format. A label printing program is available from ftp.bruker.de/pub/nmr/SAMTRACK/INSTALL/LabelDesigner
  The HOLDER keyword should show only the rack/well plate specific position. Note that the sequence order, used to determine the order in which the samples will be extracted is governed by the Best Administration tool `bestadm` Holder menu.

• **Metabolic Profiler**
  Here one Gilson is shared between the SampleTrack preparation software and BEST-NMR using one Microsoft Windows Driven PC and the SampleTrack Automation software as a master. Samples may also be “delivered” under full automation control for measurement in Mass Spectroscopy Spectrometers.

• **Force Solvent Change after (Number of hours)**
  In cases where multiple sample solvents are used in a BEST-NMR environment, ICON normally sorts all samples of the same solvent and only changes solvent when no more samples of the current solvent are available. This feature while in itself sensible may be a nuisance when customers with other solvents have to wait long periods before their solvent is allowed to run. Use this setting to force a solvent change at an interval which suits your environment.

### 5.5.1.5 Locking Shimming Options

**Locking**

- **Automatic Lock Program**

Here you may define exactly what ICON’s driver does when trying to lock. With the Skip option you can tell ICON to skip locking altogether e.g. lock externally
from the acquisition AU program, or just run a few samples without the lock.

The default value for this setting is:

LOCK #Default

You can enter any TopSpin command here, including AU programs macros or commands you would normally enter on the command line. The CPR_exec_wait or CPRW macro command tells TopSpin to execute the following and wait for the command to finish. You must always include this to execute your command.

In determining whether the command was successful, the returned string is parsed when the CPRW macro completes. If the string returned is not NORM_TERM, then ICON-NMR will show a failed status. More complicated TCL macros may be managed by copying them to the _iconnmrrc file in the home directory of the user who normally starts ICON-NMR.

If you want an AU program to be executed and ICON to wait until the AU program is finished then you should use the XAU macro, instead of the CPR_exec_wait macro:

    XAU auprogram args

where auprogram is the name of your AU program and args are any arguments you may wish to forward it.

Should you wish the command to be executed in the background (without waiting for completion) use the command CPR_exec or simply CPR

Multiple commands may also be entered, each command should be separated by a “;”. The “#” signifies that a comment follows.

With TopSpin many commands which have to do with TopSpins Graphical User Interface will need to be started via the sendgui macro, so for example to start the bsms display the text would be:

    SENDGUI bmsdisp

**Delays** may also be included before or after a command if required. To wait 60 seconds before locking include the following text before the LOCK macro:

    after 60000;

If you’re familiar with TCL, the tool command language from John Ousterhout,
feel free to enter TCL commands here too. Longer TCL procedures may reside in the _iconnmrc file in the startup user’s home directory.

**Delays after command execution**

Care should be taken to preserve the return value of the command if a delay is to be added after its execution. Otherwise ICON will not be able to tell whether the command completed successfully.

So if a delay is necessary after a command then the command used should take the following form:

```
set lock_result [LOCK];after 90000;set lock_result
```

where in this case the locking is done by the LOCK macro and a delay of 90 seconds is to be waited after lock completion.

- **Abort Acquisition on Shim Failure**
  
  Normally problems on shimming are not regarded as being so serious as to skip the acquisition. Here you can change this to suit your environment.

- **Lock only after a solvent change**

  Should ICON only try to lock when the solvent has changed, activate this flag. This feature is only available in mode.

- **Shimming**

  ICON-NMR has lots of features to help you optimize your Automation run to the limit.

  **Shimming Controls**

  - **Automatic Shim Program**

    Use this to decide which type of shimming you’ll be using. ICON-NMR provides 3 default options:

     **Default**

     TUNESX
Shim based on the probe/solvent dependent tune file saved when you setup the
system using edprosol TOPSPIN commands.

GRADSHIM

Use the gradient shimming automation program to greatly increase the shimming
performance (you need gradients installed on your spectrometer).

TOPSHIM

Another gradient shimming based shim optimization routine.

Skip Shimming

Use this setting when shimming is not required, or where the shim control is han-
dled externally, (e.g. by the Acquisition AU program see the AUNM parameter).

You may of course enter your own command here. For simplex shimming (with
your own tune file) You could enter a command like:

TUNE mytunefile

The mytunefile can be generated using the edtune TOPSPIN command. You’ll find
example tune files in:

TOPSPINHOME/exp/stan/nmr/lists/group

Delays may also be included before or after a command if required. To wait 60
seconds before shimming include the following text before the TUNE/GRAD-
SHIM macro:

after 60000;

The argument to the TCL after command is in milliseconds.

If you’re familiar with TCL the tool command language from John Ousterhout,
feel free to enter TCL commands here. Longer TCL procedures may reside in the
_iconnmrrc file in the startup user’s home directory.

Be aware that the Driver examines the return string from the macro and should it
be anything other than NORM_TERM, an error will be shown...

Delays after command execution
Care should be taken to preserve the return value of the command if a delay is to be added after its execution. Otherwise ICON will not be able to tell whether the command completed successfully.

So if a delay is necessary after a command then the command used should take the following form:

```bash
set shim_result [GRADSHIM_WITH_AUTOSHIM];after 90000;ser shim_result
```

where in this case the actual shimming is done by the GRADSHIM_WITH_AUTOSHIM macro and a delay of 90 seconds is to be waited after gradshim completion.

- **Shim the sample**
  Specify how intensively the shim routine is to be called.

- **Maximum Shim time per iteration**
  Here you can indirectly specify just how long the shimming part of the automation will run. This limit applies to each gradient as defined in the tune file. If the time limit is exceeded on any iteration then that gradient is skipped and the next gradient started. If the time limit is exceeded at any stage ICON-NMR will mark the shimming as failed, but the experiment will still be performed.

- **Total Time allocated for tune command (minutes)**
  To ensure that the length of time taken for shimming remains manageable, regardless of how many iterations are performed, set this field accordingly. If TopSPIN is still shimming after this time has expired the automatic shim routine will be halted and the experiment acquisition will commence.

Note:

From ICON-NMR 3.1 onwards, you may control exactly what ICON does when it gets to the lock or shim stage in Automation on a per sample basis. For this feature to work you must first enable the Edit Lock/Shim/ATM permission on a per user basis (on the User Manager Page). An edit button showing a lock curve will be available in the Automation Experiment setup window for each experiment to be run.

5.5.2 Automatic Shim File Loading

ICON-NMR has facilities to load a particular standard shim file in Routine Spectros-
copy and Automation modes. The shim files are loaded automatically each time a new sample has been inserted into the magnet, before the system reaches the lock stage. That way it is always ensured that the system is in a well defined state for each new operator/sample. The shim files will be linked to the solvent and the probe being used.

This window consists of a list of file entries (one for each solvent). The file entries apply to the probe which is shown in the Current Probe Type box. The entries are self explanatory, see Figure 5.4.

- **Lock noauto**
  For some solvents with several strong peaks, the lock program may lock on the wrong one. The lock noauto flag will cause the lock program to lock on that peak nearest to the field value stored in the /conf/instr/<spectrometer>/2Hlock file for the particular solvent. The command 'lock -noauto' is used instead of the standard 'lock -acqu' for these solvents.
  Settings made in this window also cover the behaviour of the 'lock -acqu' or 'lock <solvent>' commands in TOPSPIN. For all solvents with the checkbox active the handling of the 'lock -acqu' will cause the LOCK command to be issued, instead of the usual AUTO_LOCK BSMS command.

- **Lock fieldupdate**
  The solvents which are activated in this list will have their FIELD value in the 2H/19F-lock file updated automatically once per day, provided they are locked with AUTO_LOCK. This update will be performed after locking. Settings made in this window will also affect the behaviour of the 'lock -acqu' or 'lock <solvent>' commands in TOPSPIN.

- **Associated Shim Routine**
  In cases where the default Shim Routine is not to be used for a particular solvent/probe combination, use these entries to define which Shim routine should be used. If the shim routine is defined in the Automation window its setting will override whatever is defined here.
5.6 Automatic Tuning/Matching

The latest probes are equipped with tiny motors so that their tuning and matching characteristics may be varied under software control. The TopSpin command \texttt{atma} tunes and matches the probe automatically according to the NUC settings in the current data set. ICON can, if required, run this program automatically.

The ATM setup page contains the Enable ATM Optimization flag used to globally enable/disable all ATM activity. There is also an Use Fast (Coarse) Optimization mode to run the ATM in the fastest possible mode. It makes sense to switch this on for automation. In most cases the optimization will be sufficient. Apart from that it also contains a list where matching and tuning may be enabled and disabled on a per experiment basis. You can either use the copy button at the bottom right of the page to change elements of the selected experiments, or use the right mouse button when over an entry to get a popup menu whereby the underlying entry may be set.

Possible settings include “Always”, “Never”, “after a solvent/nucleus change” for...
both H and X channels respectively. Nucleus change refers to X-Nuclei. ICON checks the Nuclei NUC1, NUC2, NUC3 and NUC4 and compares them to the last time it had X-Nuclei. If there is a difference, an atma command for the X-Channel will be issued.

**Note:** Users may be granted permission to edit the ATM setting for any experiment when logged into the Automation set-up mode. The Edit Lock/Shim/ATM permission checkbox in the user manager controls this feature.

### 5.7 Priority Options

These options only apply to the Automation part of ICON-NMR.

- **Enable Priority**

  Here you may globally disable priority handling, including Day/Night checking altogether. This will speed up ICON’s search for the next sample. If you don’t plan on having priority samples then leave this option off.

### 5.7.1 Strategy

These options determine (in general) how priority requests will be handled.

- **Modes accounted for**

  Determine what levels of Priority you wish to cater for. Options include Night & Day, Priority Only, Priority and Night & Day.

- **Priority Sample Handling**

  Decide whether ICON should jump to a priority sample immediately. This is a hardware/time unfriendly setting as the sample changer will move to a priory sample even if more experiments are queued for the current sample. The default is for the sample holder only to be changed to the priority sample after all experiments have been completed on the current holder. This saves unnecessary wear on the sample changer as well as system overhead (i.e. the uncompleted experiments on the currently active holder will have to be locked and shimmed again!).

- **Use “First come first served” model**

  Normally, ICON looks for submitted samples on the next highest holder, ignoring
the time at which the sample was submitted. It will proceed to that holder and insert the sample. This saves time and reduces the wear and tear on the BACS sample changer. This corresponds to the “Never” setting. From ICON-NMR 3.5 onwards, the mode may be changed, such that the submit time be taken into account. Samples are then measured, based on the time at which they were submitted. You’ll also find an “Only at night” option which should also help in situations where night time experiments were not being executed, simply because they were at the wrong holder position.

Note:

The program looks at the modification time on the “status” file in the temporary data set when determining the submission time. This time has a resolution in seconds so all experiments submitted during the same second have the same submission time. The First come first served setting is equivalent to the current “workaround” of setting the priority toggle on all samples before submitting them.

- Randomize Measurement Order
  This may be of interest in cases where spectra are being acquired which are to be used later for statistical purposes. A sample is chosen “at random” from all submitted samples. In BEST-NMR this will be handled on a per well plate/rack fashion. Samples will be randomly chosen from the current container (well plate/rack) until all available samples have been measured.

- Night Day Switch-over
  Set the times used for night-time experiments. You can also specify whether night time experiments should be allowed to run during idle Day time.

- Night Experiment Duration for Idle Limit
  Chances are that customers who wish to allow night experiments to run during idle day time will have certain experiments which are very long which should really only run at night - and others which are shorter though not short enough for regular daytime measurement. Here one can determine where the cut off experiment time should be for a night time experiment such that it be run in idle day time.

### 5.8 LC-NMR Options / Sample Track Options

For further information on these settings see the LC-NMR and Sample Track Manuals respectively.
5.9 Temperature Handling

ICON-NMR has features to set and check the temperature before and after sample insertion.

This system is currently available to customers using BACS sample changer, Manual Inject/Eject LC, MAS and SampleTrack Automation driver engines. Post insertion checking is now available for NMR Case and SixPack sample changers.

Provision is made for checking and controlling the temperature both before and after sample insertion. Users can set a fixed temperature for all experiments on the sample, or use the temperature setting “according to each experiments TE parameter”. The TESET macro sets the temperature while the TEREADY macro waits until the required temperature has been attained.

TEREADY takes two arguments: The first argument defines an equilibrium time which is inserted after the temperature unit reports that the temperature, with reference to the tolerance, has been reached. The second parameter determines to what degree of accuracy the program should require temperature conformance to the desired value. Where multiple experiments are run on a single sample, the temperature will be updated according to the Post insertion routine. If the temperature is to be changed between experiments, in cases where the required temperature does not change the Temperature Set/Check routine will automatically be skipped.

For VT experiments in Automation it’s a good idea to define TE as a user specific parameter. That way you can access the TE value quickly from the experiment definition line.

5.10 Fail Safe / Error Handling

- Activate Watchdog timer
  A watchdog timer has been incorporated into the software which is started automatically whenever a spectrometer operation is started on the instrument. The timer is set to a 30 minute interval. If the operation has not responded after this time, ICON-NMR will assume the operation will not complete and the run will be terminated and restarted. Measurement will pick up where it had left off,
so for example, if the acquisition was the problem, then only the acquisition will be restarted.

The acquisition time is taken into consideration and the experiment will only be terminated if the acquisition time plus the Standard Timeout time has expired.

- Configure TopSpin to respond automatically with “Cancel”...
Software controlling the measurement can, if it has been programmed without any consideration for Automation, easily ask a question requiring user input before continuing. Such software can then block automation waiting for an answer for days on end. Activating this feature will cause the question to be cancelled. The software which issued the question will receive an answer equivalent to the User having clicked the “Cancel” answer.

5.11 General Options

- Archiving Copy User (Unix only)
If root access on the workstation is allowed, directories will be generated where needed. If you use the normal user action, ICON-NMR may not be able to copy the data if the directory structure does not already exist.

- Include Originator Information in Title
Normally the originator information will be stored in the title file. Use this option to disable this feature. Originator Info will in any case be stored in the data set, in the file “orig”. For more information on Originator Entries See “The Originator Items Editor” on page 95..

- Include Experiment/Sample Information in Title
Here a range of information will be copied automatically into the title. Items copied include the holder position and experiment name. For BEST-NMR the Rack label and type will also be copied automatically.
5.11 General Options

- Modify data set permissions after processing

ICON-NMR always acquires on a data set which has ownership according to the currently logged on Workstation user. After processing has completed however, the permissions and ownership will be changed according to the user who submitted the experiment and the Umask setting in the User Manager. You may turn this feature off by disabling this entry.

- Display all TOPSPIN Warnings

Here you may instruct TOPSPIN not to display any dialog windows of type “Seen”. The information will however still be reported in the TOPSPIN history file.

- Experiment Number Automatic Increment

Normally a space of 10 experiment numbers will be left for additional experiments on any given sample. Use this dialog to change this.

- Flash Entry Zones

This applies to Routine Spectroscopy only. The blinking frames red and green frames may be deactivated using this checkbox option.

- ICON Color Palette

Some other programs may not be able to get their default colors when ICON is running. Use this option to reduce the number of colors requested by ICON. This may alleviate the problems in other programs as more colors will be available for them. You may even run ICON in black and white mode, for that great 50’s black and white movie feeling!

- Password Checking

For those of you working in a trustworthy environment, use this menu to slacken the password checking mechanism in ICON-NMR. You may disable checking altogether, or reduce password checking to Manager Items and start-up with the ‘Sen-
sitive Tasks Only’ option.

- **Font Size Adjuster**
  Here you make limited adjustments to the font size used in all ICON-NMR programs. Changes will be made after a restart of the program.

- **SMTP Mail Server**
  Enter the name of your company/institution mailserver here. ICON will contact this server and attempt to use it for the transmission of all mails if a value is entered. If ICON is unsuccessful a TopSpin error will be generated and will be visible in the TopSpin history file.

- **Automation Error Handling**
  This feature available only in Automation mode allows for even more Instrument supervision. If one of the systems being used in Automation fails completely, for example the lock, then the complete Automation Run may be stopped automatically. Optionally you may choose to allow the run to continue and should you enter a valid E-mail address in the space provided, a notification Mail informing of the error will be sent to the given address. Multiple addresses may be separated by semicolons.

  This feature is especially useful in BEST mode where invalid results may not necessarily be corrected by running a second time (insufficient sample).

- **JDX Copy Mode**

  From ICON-NMR 3.1 onwards, ICON will generate JCAMP-DX files automatically at the end of the measurement/processing and copy them to the directory which may be entered here. It is also possible to define which filename will be used for the file. Use the File Naming format to decide how the files are to be called. Click on the pulldown menu to see some examples. The Keywords $DATASETNAME, $EXPNO, $USER, are available together with $RACKTYPE, $RACKLABEL and $HOLDER for BEST-NMR use. The first three variables are available in both Routine Spectroscopy and Automation modes.

  If processing has been disabled, then only the fid may be converted. All other modes will be ignored. Both 1D and 2D data formats are catered for by the
5.12 File Menu Functions

tojdx command and as such are catered for.

The directory used may contain the $USER variable to make the target directory user specific.

- JDX Compression mode:
  Define the compression mode to be used here

See the tojdx command in the TOPSPIN Users Guide for more information.

5.12 File Menu Functions

File->Load and “Save as”

All the options except for those from the “User Manager”, “Composite Experiments”, “Additional Users” and “Originator Items” settings may be saved into files for future changes. For example if you have an setup where you use gradient shimming together with particular temperature handling options and another setup where you never use the temperature options or temperature options you may switch back and forth easily by using the File->Save and File->Load menu entries.

- Load
  Here you may reload previously saved configuration settings.

- Save
  Any changes made in the configuration window including possible changes in windows which contain a “Save” button (User Manager, Composite Experiments) are written to their respective files.

- Save as
  Saves a copy of the configuration settings for all windows apart from the 4 mentioned above into an “Icon-NMR Configuration” file with the extension .icf.

- Restore defaults
  Sets all options apart from the 4 above mentioned pages back to their original settings.

- Update Run Parameters
  Activating this command forces an already active run to reset the “Driver Engine” parameters which normally are only read once (at the beginning of the
run). Parameters which obviously have nothing to do with the run, for example User Manager settings will not be updated.

The changes will be made after the current action has completed. So if for example, the default locking procedure is to lock automatically using the LOCK macro, and the instrument is currently locking then the change will come into effect next time the system reaches the lock stage.
6.1 Entering Routine Spectroscopy mode

You enter Routine Spectroscopy mode by clicking on the respective icon of the ICON-NMR main desktop. A flashing icon will invite you to identify yourself. To exit click on the Exit button of the File menu.

6.2 User identification

6.2.1 Identify yourself

When you click on the identify user icon, a dialog box (Figure 6.1) is opened which displays a list of possible spectrometer users. Select your user id from the list either with a single mouse click, followed by a click on the OK button, or double click on your ID. The program will then request your password. If your ID does not appear in the list, use the User Manager, accessible from the Configuration Menu to create a userfile for yourself.

User ID’s and passwords

The user identification dialog box similar to that shown in Figure 6.1, will contain
the ID’s of all users which have both an account on this workstation and a user file defined using ICON-NMR’s User Manager window. In addition, the box includes the ID’s of so-called NMR users. NMR users need not have their own workstation account. Instead, they are defined by the laboratory manager on the Additional Users page of Configuration where they are assigned an ID and, if desired, their own password.

In other words, legal workstation users may enter Routine Spectroscopy mode, as well as other people to whom the administrator wishes to grant access to the spectrometer by adding them to the NMR users list.

An NMR user who does not have a password must use the effective NMR user’s password. This is a legal workstation user on the workstation who was defined to be the effective NMR user by the laboratory manager on the Additional Users page of the ICON-NMR Configuration window.

Figure 6.1 User identification
The user ID selected to get into *Routine Spectroscopy* mode has a direct influence on the ownership of the acquired data. If your ID is a legal login ID, the data will get read/write access permissions for yourself and all members of the Unix group you belong to. You may alter this using the Umask setting in the User Manager. If you are an “NMR user”, the data access permissions are those of the effective NMR user.

### 6.3 The *Routine Spectroscopy* desktop

#### 6.3.1 The flow chart

If your identification was successful, the window of Figure 6.2 (left side) will appear on the ICON-NMR desktop containing icons that are arranged as a flow chart in order to guide you in the appropriate way through the set up steps required before the experiment can be started. As you can see from the flow chart, there are only a few operations to perform: Inserting the sample into the magnet, defining a file name, defining the solvent, and defining the experiment. Then you are ready to click on the *start* button to execute the experiment. Before that, you may at any time repeat a set up step to apply any corrections.

The flow chart can be displayed in two modes by clicking the *Status* toggle button. The second mode (Figure 6.2, right side) shows a status panel appended to the chart which allows you to view the parameters defining the current experiment. If anyone of them remains *undefined* (except for the title parameter), you cannot start the experiment. Please note that within the status panel no parameters modifications are possible.

#### 6.3.2 The *File* menu

This menu contains the *Exit* command to terminate the *Routine Spectroscopy* desktop. After successful log in the Exit to Iconnmr button may be used to leave the routine mode without returning to the identify user stage.

#### 6.3.3 The *Options* menu

This menu contains the following commands:

- **Manual Locking and Shimming**
  
  If the check button *Manual Lock/Shim* is activated, the acquisition software will
neither lock the field nor shim automatically. These tasks are left to the user: As soon as the procedures are required after starting the experiment, a dialog box will invite the user to execute them manually. Manual locking and shimming require a permission to be set in User Manager mode.

Figure 6.2 Routine spectroscopy flow charts without/with status panel
• **Change password (only available for NMR users)**
  This command allows the current ICON-NMR user to change his password.

### 6.3.4 The **Configuration Menu**

This menu contains the following commands:

- **CONFIGURATION**
  Use this to define global features of ICON-NMR, like the shimming method to be used before Acquisition, or the default increment to use for the experiment numbers. See “Configuration Suite” on page 79 for more details.

### 6.4 The **Inject/Eject icon**

Figure 6.3 (left side) shows the window which appears when you click on the *Inject/Eject Sample* icon.

The window has 2 different modes of operation *Manual* and *Sample Changer operation*. To use the sample changer mode the unit must have been configured using the `cibacs` XWIN-NMR command.

The manual mode consists of a *command sequence* panel, and a command panel with a flashing frame, inviting you to select a command. Choose either *Exit* to close the window, or *Insert Sample* to turn on the sample lift. A sample residing in the magnet will be lifted, and a dialog box will ask you to insert a new sample. The command sequence panel monitors the actions of the spectrometer during this procedure.

After the experiment has been successfully completed the *Inject/Eject* window will also contain the buttons *Eject + Terminate*, *Use Same/Continue* and *Insert New Sample*. The *Eject + Terminate* button ejects the sample from the magnet, and subsequently terminates the current ICON-NMR routine session. *Use Same/Continue* increments the experiment number by one leaving the sample in the magnet, while the *Insert New Sample* starts the change sample procedure.
6.5 The *Filename* icon

6.5.1 Selecting the data set name

When you have inserted a sample in the magnet, you must define a data set name for the fid and spectrum to be acquired. The dialog box of Figure 6.3 (right side) will be opened as soon as you click on the *Filename* icon. The data set filename follows the conventions of XWIN-NMR, where an fid is stored in the directory

/\du\data\user\nmr\name\expno/

The corresponding spectrum is stored in

/\du\data\user\nmr\name\expno\pdata\procno/

DU is the disk unit or partition where the data will be stored. If for a particular user only a single partition is provided in the *User Manager* mode, DU will not appear in the *Filename* selection box. Otherwise a user may select the desired DU from a list.

USER is the identification code a user typed in to enter *Routine Spectroscopy* mode. It not only defines the location of the data on disk, but also the access rights for the data (cf. section for details).

NAME is a string to identify the data files of a particular sample. A user enters the desired name into the respective text entry field, or selects the name from a given list by clicking on the *Names* button right of the entry field. The list is defined for each user in the *User Manager* mode. In this mode, the *Data Set Edit* checkbutton can be set, so that a user can only use the names on the list, but not enter his own particular name. Furthermore, a *Spectrum Number* file may be set up which automatically assigns a system wide, unique name for each sample used (see Section 4.8).

EXPNO is a number with the default value 10. The purpose of EXPNO is that a user may keep the same NAME for several experiments, but differentiate the data by another EXPNO. We recommend you increment EXPNO by 10 to prevent a conflict with the EXPNO counting used in *composite experiments*. A composite experiment actually performs several experiments, e.g. a 1D preparation experiment followed by a 2D. ICON-NMR will increment EXPNO by 1 in these cases.

PROCNO is a number with the default value 1. It need not be changed in *Routine
6.5 The Filename icon

6.5.2 The originator information

Several other items may appear in the Filename selection box, such as the Department or the E-mail address in Figure 6.3. This so-called originator information can be configured in User Manager mode by invoking the Originator Items Editor. The originator information, if present, will automatically be appended to the plot title. See “The Originator Items Editor” on page 95.

6.5.3 Command buttons

The Filename box provides the following command buttons:

- **OK**
  
  Accept all changes and return to the Routine Spectroscopy flow chart.

Figure 6.3 Inject/Eject and Filename dialog boxes
• **Cancel**
  Discard all changes and return to the *Routine Spectroscopy* flow chart.

• **Continue**
  Accept all changes and carry on with the next item of the *Routine Spectroscopy* flow chart, i.e. open the *Solvent* selection box.

### 6.6 The *Solvent* icon

#### 6.6.1 Selecting the solvent

The *Solvent* and *Experiment* selection box (Figure 6.4) is shown when you click on

![Figure 6.4 Solvent and Experiment selection window](image)

the *Solvent* icon or on the *Continue* button in the *Filename* selection box. Choose the solvent for your sample.
6.7 The Experiment icon

The solvent list displayed is the list setup by the laboratory manager with the command `edsolv` during XWIN-NMR configuration.

6.6.2 Command buttons

The **Solvent** box provides the following command buttons:

- **OK**
  Accept the selected solvent and return to the *Routine Spectroscopy* flow chart.

- **Cancel**
  Discard the selected solvent and return to the *Routine Spectroscopy* flow chart.

- **Continue**
  Accept the selected solvent and carry on with the next item of the *Routine Spectroscopy* flow chart, i.e. open the *Experiment* selection box.

6.7 The **Experiment** icon

6.7.1 Selecting the experiment

The *Experiment* selection box (Figure 6.4, right side) is shown when you click on the *Experiment* icon or on the *Continue* button in the *Solvent* selection box. Choose the desired experiment for your sample.

The experiment list displayed is user dependent and setup by the laboratory manager in *User Manager* mode. See “The Experiment List box” on page 82.

6.7.2 What is an experiment?

Each experiment name in the list is associated with a set of acquisition, processing, and plotting parameters stored in the directory:

`TOPSPINHOME/exp/stan/nmr/par/<experiment name>/`

Bruker provides a pool of the most important experiments with its software, installed at XWIN-NMR configuration time with the command `expinstall`. The laboratory manager may define additional experiments using the XWIN-NMR `eda`, `edp`, `edg`, `tpar`, `wpar` commands.

Some experiments are denoted as *composite experiments* defined in the *Composite*
Experiment Setup mode of ICON-NMR. A composite experiment is a sequence of normal experiments which you define in Set Composite Experiment mode. The member experiments of a sequence may depend on each other. For example, the first experiment of a sequence could be a preparation experiment for a subsequent 2D experiment. In such cases, the composite experiment manager allows the laboratory manager to specify the reference experiment(s).

When an experiment is started, a sequence of preparation steps for data acquisition are executed, followed by the acquisition of the fid(s), followed by data processing and plotting. The preparation steps select the preamplifier, adjust the lock, the shims, and the receiver gain, controlled by the TCL script

```
TOPSPINHOME/prog/tcl/xwish3_scripts/inmr_scripts/qnmr_sx_tcl
```

The actual data acquisition is performed by the AU program AUNM which an acquisition parameter defined in the experiment. AUNM may be modified by using the eda parameter editor before experiment start.

For processing (Fourier transform, phasing, integration) and plotting, the tcl script calls the AU program AUNMP, which is a processing parameter of the experiment. The AUNMP parameter may be modified with the edp parameter editor.

6.7.3 Command buttons

The Experiment box provides the following command buttons:

- **OK**
  Accept the selected experiment and return to the Routine Spectroscopy flow chart.

- **Cancel**
  Discard the selected experiment and return to the Routine Spectroscopy flow chart.

- **Set Plot Title**
  A text entry window is opened where you can type in one or several lines which will become the title of the spectrum plot. The title window will already contain the originator information if defined. When you terminate the window by clicking on its OK button, the title text will be saved in the following file where it is looked up by the plot software:

  `/DU/data/USER/nmr/NAME/EXPNO/pdata/PROCNO/title`
6.7.4 Modifying parameters

After an experiment has been defined, its acquisition, processing, and plotting parameters are initialized from the standard parameters for this experiment. Using the commands of the Parameters menu, the parameters can be changed before the Start icon is activated. The standard parameters sets will not be affected. Parameter modification requires the governing permission checkbutton to be set in User Manager mode.

6.8 The Start icon

Once everything is setup correctly, i.e. the sample is in the magnet, file name, solvent, experiment, and plot title are defined, the traffic light in the START icon will turn green and you may the activate the Start icon to launch the experiment.

6.8.1 The acquisition in progress window

After starting the experiment, the flow chart will be overlayed by the acquisition in progress window (Figure 6.5) containing the file name and EXPNO, the remaining time the experiment needs to finish, the experiment name and its comment line. The figure shows EXPNO=31, which in this case indicates, that a composite experiment is in progress: The 1D reference experiment had EXPNO=30.

The window provides the following command buttons:

- **FID**
  Displays the fid being acquired in real time.

- **Spectrum**
  Displays the spectrum being acquired in real time.

- **Lock**
  Displays the lock signal in real time.

- **Halt**
  Halts data acquisition when the current fid is complete and stores it on disk for further processing using the Plot button.

- **Plot**
  Processes the fid stored on disk when Halt was pressed and plots the spectrum. In fact, the AUNMP AU program is called for this purpose. If processing has already been carried out, this button merely plots the spectrum afresh.
Exit
Returns to the flow chart. This button is not active while the experiment is in progress.

Stop
Stops all spectrometer activity immediately. No valid data will be available afterwards.

Search
After an experiment has been completed this button may be used to look at previously acquired spectra.

6.8.2 The acquisition status icons

These icons allow you to observe the current experiment status. Whenever the program begins to execute a particular procedure, the corresponding status icon will
6.8 The Start icon

<table>
<thead>
<tr>
<th>Initialize</th>
<th>Lock</th>
<th>Shim</th>
<th>Gain</th>
<th>Acquire</th>
<th>Process</th>
</tr>
</thead>
</table>

Figure 6.6 Acquisition status icons

blink until the task has been completed. When processing is finished, the exit button will be enabled. Using this button will return control to the flow chart for setting up the next sample.

6.8.3 The accounting file

Every experiment started in ICON-NMR will generate an entry in the accounting file

/TOPSPINHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.brief and

/TOPSPINHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.full

The .brief files contain only essential information and are shorter.

Table 6.1 shows the initial section of such a .full file which reports the spectrometer users and the experiments they performed, including the time and disk space requirements. The file will grow with time, and it is the responsibility of the laboratory manager to archive and delete it periodically. Such accounting files are the basis for the accounting manager provided by ICON-NMR which generates an invoice for any user, user group etc. based on unit prices per hour of spectrometer time and Megabyte of disk usage.
---- IconNmr Accounting File

---- Created Tue Jan 23 12:31:50 MEZ 1996

#Login
name: mg1
host: bigi
group: user 20
date: 01/23/96 12:32 822396721

#Spectrometer: DPX250

#Experiment
nameOfExperiment: PROTONNREXP
solvent: Acetic
fileName: Mark2076 40 1 u mg1
fileSizeAcq: 32768
fileSizeProc: 16384
NUCLEUS: 1H
INSTRUM: DPX250
timeOfStart: 01/23/96 12:32 822396744
timeOfTermination: 01/23/96 12:33 822396824

#User Specific Info
Email Address: mg@bruker.de

#Logout
date: 01/23/96 12:33 822396838

Table 6.1 Section of an accounting file
Chapter 7
The Accounting Manager

7.1 Introduction

The accounting software is started from the Accounting icon in System Manager mode. It gathers the information required to calculate prices for spectrometer usage from an accounting file. The structure of an accounting file has already been discussed in the Routine Spectroscopy section of this manual. Each time an experiment is executed under control of ICON-NMR, the standard accounting file:

TOPSPINHOME/conf/instr/<instrument name>/inmrusers/Inmracct.brief

is updated.

At start up time the accounting program collects and sorts all user information stored in this file. Depending on its size (which can grow significantly during e.g. a month’s period), you will have to wait some time until the dialog box similar to the one shown in Figure 7.1 appears.
Figure 7.1 Accounting dialog box
7.2 The File menu

The following commands are available:

**Open accounting file**
By default, *Inmracct.brief* is the standard file responsible for all accounting information. However, the accounting information search can also be performed on other files with the extension *.brief*. The *open* command will display all files of this type stored in the directory `TOPSPINHOME/conf/instr/<instrument name>/inmrusers/`. Select the one you wish to use for accounting. Its name will be displayed in the header bar of the dialog box. After you have chosen a new file the accounting information is collected and sorted. This process may take some time, so please be patient.

**Exit**
Terminate the accounting program.

7.3 The Report menu

The following commands are available:

**Display on screen**
Re-display the report generated via the Start button.

**Print**
Print the report generated via the Start button on the current printer.

**Save as**
Store the report generated via the Start button in the specified file. If the file name does not begin with a “/” character, the report will be stored in the login user’s home directory.

7.4 The Accounting for box

In this box, you enter the users or the department etc. for which you want to generate an accounting report. The accounting mode is also selectable.

- Enabling the *User* button will instruct the accounting software to generate a report for the user which you may select from a list. Click on the down arrow
button to the right of the User button to display the list. This list is determined at startup time from the standard accounting file, or from the file you have chosen via the Open command in the File menu. The special list entry All will compile a report for all users present in the list.

- The Group button is similar to the previous User item, however, accounting is performed for the specified Unix group. The special list entry All will compile a report for all groups present in the list.

- Enabling the Originator button provides the most flexible accounting method in the per Experiment mode. Click on the down arrow button to get the list of originator items displayed that you have set up with the Originator Items Editor, and select one of them (e.g. Department). Enter the suitable accounting criterion into the field to the right of it (e.g. a department identifier).

You may also search using wildcards the following wildcards are available:

- •* Matches any sequence of characters in string, including a null string.
- •? Matches any single character in string.
- •[chars] Matches any character in the set given by chars. If a sequence of the form x-y appears in chars, then any character between x and y, inclusive, will match.
- •\x Matches the single character x. This provides a way of avoiding the special interpretation of the characters *?[] in pattern.

Example 1:
Assume you have selected the accounting type Department. The item Department is member of the list because you have defined it as originator item with the Originator Items Editor. Assume further that in your organization departments are identified by numbers. In order to generate the accounting report for the department 8009, enter this number as the accounting criterion. As a result you will get the total sum of spectrometer usage for all users belonging to this department.

Example 2:
Assume you have selected the accounting type E-mail Address. The item E-mail Address is member of the list because you have defined it as originator item with the Originator Items Editor. Assume further your E-mail addresses have the general form user@organisation.country. In order to generate the accounting report for all users belonging to organization, enter the text @organization as the accounting criterion. Accounting would then be performed for all users of organization.
This example indicates that the accounting program applies a slightly different identification method to alphanumeric text as compared to plain numbers: In the first case substring matching is employed, while numerical must be matched exactly.

- Setting the *per Experiment* mode will instruct the accounting software to account the time between the start and end of an experiment.
  - Setting the mode *per Login* will instruct the accounting software to compute the accounting information based on the time between Login and Logout.

### 7.5 The Accounting Period and Unit Prices

Please fill in the date of the first and last day of the accounting period (the sequence is month, day, year). If you want to charge night time rates specify the start and end time. Otherwise set the time of night start and end to 0, in this case the accounting program requires less calculation time. Then fill in unit prices that you intend to charge to the spectrometer users: A unit price per hour of spectrometer usage and a unit price per megabyte disk storage consumed during the accounting period. The total is calculated according to

\[
\text{total} = \text{number of hours of spectrometer usage (day)} \times \text{unit price per hour (day)} + \\
\text{number of hours of spectrometer usage (night)} \times \text{unit price per hour (night)} + \\
\text{number of Megabytes consumed} \times \text{unit price per MByte}
\]

If you don’t want to charge for the disk space, set the unit price per MByte to 0.

You can also enter a currency. The program will append it to all prices printed in the report, but will not perform any calculations with it. You can select the currency from a list. If you don’t find that of your country, you may add it to the file

```
/u/prog/<version>/curdir/<user>/currency
```

Next time you enter the accounting software, your own currency will be included in the list. You may also delete unwanted items from this file.
7.6 The Start button

The program will start accounting according to the parameters you have defined during the previous steps, and display the report. Figure 7.2 shows a typical report including the performed experiments. The number close to each experiment name indicates the number of times this type of experiment was executed during the accounting period. The report also lists incomplete experiments which have been started but were interrupted either by the operator or because of an error situation. Failed experiments are not included in the price calculation.

<table>
<thead>
<tr>
<th>Accounting File: /usr/adm/Inmracct.brief</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting mode: per Login</td>
</tr>
<tr>
<td>User: guest</td>
</tr>
<tr>
<td>Accounting Period: from 01/01/96 to 01/31/96</td>
</tr>
<tr>
<td>Spectrometer time (day): 5 h 15 min</td>
</tr>
<tr>
<td>Spectrometer time (night): 0 h 31 min</td>
</tr>
<tr>
<td>Disk Space total: 2.81543 MByte</td>
</tr>
<tr>
<td>Unit Price per hour (day): 25 US$</td>
</tr>
<tr>
<td>Unit Price per hour (night): 10 US$</td>
</tr>
<tr>
<td>Night time: from 17:00 to 7:00</td>
</tr>
<tr>
<td>Unit Price per 1 MByte disk space: 10 US$</td>
</tr>
<tr>
<td>Number of experiments: 51</td>
</tr>
<tr>
<td>List of experiments:</td>
</tr>
<tr>
<td>7 x PROTON</td>
</tr>
<tr>
<td>11 x PROTON128</td>
</tr>
<tr>
<td>5 x PROTONEXP</td>
</tr>
<tr>
<td>28 x PROTONNREXP</td>
</tr>
<tr>
<td>Please note: Incomplete experiments:</td>
</tr>
<tr>
<td>2 x PROTON</td>
</tr>
<tr>
<td>Item price time: 131.35 US$</td>
</tr>
<tr>
<td>Item price disk: 28.15 US$</td>
</tr>
<tr>
<td>Total price: 159.50 US$</td>
</tr>
</tbody>
</table>

Figure 7.2 Accounting report example
Index

Symbols
$DATE 87
$DATEUSER 87
$NUMERICDATE 87
.currenc file 139
.mailaddr 97
.pooltxt file 99
.set extension 37
<user id> file 94
A
accounting 93
accounting file 133
accounting manager 135
accounting period 139
acquisition in progress window 131
acquisition status 132
adding experiments 32
Amix-Viewer 101
anchored entry 28
archive data 84, 91, 116
atm 112
atma 86
audit trail 91
AUNM parameter 109, 130
AUNMP parameter 130
automatic run 103
Automation 40
automation 23
Automation Manager Window 23
Automation Tutorial 26
autostart 13
B
Bio-Nmr 59
C
cancel all acquisition 132
changer directory 9
colors 117
composite experiment 130
composite experiment manager 82
copy mode 39
copying experiments 33
D
Data Mail 86
data set edit 85
data set filename 126
date 87
Day/Night 29, 31, 82, 114
def_comp_exps.inmr file 99
Default Solvents/Experiments 102
Default user manager option 94
defining experiments 98
Delays 107, 109
delete experiments 31, 32
Delete users 94
Disk 100
drag and drop 84
driver 35
Driver Engine 102
DU parameter 126
E
eda command 129
edg command 129
edp command 129
edsolv command 29, 129
Eject last sample 103
e-mail address 93, 96, 138
e-mail notification 86, 104
Error Handling 118
Esc 39
essential originator 85
Excel 46
exit 85
experiment 82, 129
experiments 84
expinstall command 83
EXPNO parameter 126
external setup 41, 101
F
FID display 131
First come first served 113
flow chart 123
font size 118
Function Keys 14
G
go icon 34
GOTO_NEXT_SAMPLE 67
groups 93
H
halt acquisition 131
help 21
history 25, 26, 60, 102
history list 25
holder number 100
HTML 72
HTML history 102
HTML Setup File 102

I
inject/eject sample 125
Inmracet.brief file 133, 135
Inmracet.full file 133
installation 12
introduction 19
Iterate 33
J
JCAMP-DX 86
JDX Compression 119
JDX Copy Mode 118
K
keyboard 14
Kinetic 59, 70
Kinetics 40
L
Live Data 63
Lock 86
lock display 131
lock program 106
lock using -noauto flag 111
Lock/Unlock Toolbox 63
lockdisp 39
logout idle users automatically 101
M
Mail Data/Notify to 96
mail server 118
main desktop 19
Manual Lock/Shim 38
manual locking and shimming 85, 123
mouse 14
N
NAME parameter 126
Night Experiment Duration 114
NMR effective users id 94
NMR super user 34, 95
NMR users 94, 122
numbering 117
O
Open Office 46
orig file 96
originator 85, 116
originator information 127
originator items editor 95
overwrite 105
P
par directory 63, 83
parameter edit 85
parameters 93
password 94, 125
password checking 117
PDF 85
periodical experiments 40
permissions 84, 117
plot 131
postscript 104
preceding experiments 25
Prepend 83
Printout 103
priority 84, 113
processing 103
PROCNO parameter 126
prosol 104
Q
qnmr_sx_tcl file 130
Queue Interaction 53
R
Randomize 114
reference experiment 98
routine spectroscopy 121
rpar command 129
S
sam_users_exam.inmr file 94
Sample Changer operation 125
Search 26
selective experiments 54
sendgui 107
shim 86
shim file loading 110
shim program 108
shim time limit 110
SMTP Mail Server 118
solvent 128
Spectral Viewer 101
spectrum display 131
spectrum number filename 91
Spreadsheet 46
Standard Originator Values 97
start icon 131
starting up ICON-NMR 12
stop icon 35
submitting experiments 31
supervisor 8, 85
T
target email address 86
TCL 107, 109
temporary 105
TEREADY 115
TESET 115
Tips and Tricks 40, 93, 94
title 30, 116
title file 130
tojdx 119
TOPSPINHOME 12, 97
troubleshooting 15
U
unit prices 139
UNIX password 95
Update Run Parameters 119
update user files 82
user names 81
USER parameter 126
user specific information 92
user specific parameters/commands 29, 93
W
warnings 117
WEB 49
window manager frame 19
wpar command 129